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Anmerkung fir Macintosh Nutzer

Einige Tastenbelegungen (Tastenkirzel) und Menieintrdge unterscheiden sich zwischen der
Macintosh Version und denen fiir Windows- und Linux-Rechnern. Die unten stehende Tabelle gibt
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Ihnen einige grundlegende Hinweise dazu. Eine ausfuhrlichere Aufstellung dazu finden Sie in der

Hilfedatei des jeweiligen Moduls.

Windows/Linux entspricht am Mac

Effekt

Meni-Auswahl Extras » LibreOffice » Einstellungen
Optionen

Zugriff auf die Programmoptionen

Rechts-Klick Control+Klick

Offnen eines Kontextmeniis

Ctrl (Control) & (Command)
oder Strg (Steuerung)

Tastenkirzel in Verbindung mit anderen
Tasten

Anmerkung ftir Macintosh Nutzer



Inhalt

Anmerkung flr MacintOSR NULZEL ..............uuuueeeies e et a e 2
Ly (0] 0 0 o R 6
0L LA (=] (0 o S 6
FOrMALIEIEN VON LINIEIT ...ttt ettt ettt e e et e e e e e e e e e 6
Andern des Standards fUr dig LINIE ..............c..cceeeeeeeeeeeeeeeeeeeeeeeeeee e 6
Die Symbolleiste Linie Und FUINUNG ..............uueeeeieiee ettt e 6

I (oI =1 g (=] = 7
BenutzeroberflACREN-VaAIIQNTEON ..............cceee ettt n e e e e eeennes 8
DEI DiAIOG LINIE ...ttt ettt ettt e e e eanan 9
Die REQISIEIKAITE |\ LINIE" ........cceeeeeeee ettt ettt e ettt et e e e ettt e e e e et e e et e et e e aaaeenen 9

Die RegIStErKarte ,SCRALIEN" .............cccoe ettt ettt e e e e e e 10

Die Registerkarte ,LINIENSLIIE" ..............ooemeeeee e e e e 11

Die Registerkarte ,LINIENSPILZEN .............ceeeeeeeeeeeeeee et e e e eens 13
Linienstil- und LiniensSpitzentabellen ..................coowummmuuiiiiiieee et a e 14

=T 0= o 14
LT o) (=X 1 [=T0 0 Lo 15
Der Dialog FArBAUSWANI ...............oummeeeeeiiieeee ettt 16
) > P 17

RGB ...ttt e e e ettt ittt e e e e e e e e e e e e aaanias 17
Farbleiste Und FArbPAIETLE ................ummmmmeeeeiiiee ettt 17
ZUWEISUNG VON FAIDEIN ...ttt 18
LT o] o= (= 1 (= PP 18
Formatieren von FIACHEN ...............cccoovuiiiiiiiii i 18
SYMDBOI- UNCA SEIENIGISTEN ...ttt 19
DEr Dialog FIACNE ...t 21
T 0 R (]G T (= o - T 4 = R 21
Lo (] G T (= I Yol 1= L1 (= 27
ReQIStErkarte ,, TrANSPAIECNZ" ..........cuuuee e e et et e et eee e e e e ettt e e e e e et e e ettt e e st e s aaeaasaaeesen 28
FarbBVEHAUF-WEIKZEUQ .......vveeeeeeeeeee ettt ettt e e e e e e e e e e 29
Interaktives TranSParenNZ-WEIrKZEUQ ............uummeeeeeeieeeeeeee ettt eeenns 30
FOIMALVOITAGEN ...ttt 30
Formatierung mittels einer FOrMAatVOITAQE ..............eeeeeeeriiieeeeeiiiee ettt et a e 30
Die Hierarchie von FOIMAtVOIIAGEN ..............uuuiiieeeiiieie ettt e e ttis e e e aaais e e e eeanaans 31
Definieren einer FOrMAtVOrIAge ................ccociiiiiiiiiiiiiiiiii 32
Erstellen oder Andern einer Formatvorlage aus einem ausgewéhlten Objekt ..................... 32
A'nd__ern €INEI FOIMALVOITAQE ...t ettt et et e e e eaees 33
Andern auf BasisS €INES OBJEKLS ............cceeeiiiieeeeesse e e e e e 33
LOschen einer FOrMaAtVOIIAQE ................uuueiiiiieeieeeee ettt 33
Verwendung von DOKUMENTIVOITAGEN ............uuuuueeiiiseeee ettt e e a e 34
Weitere Ver&Gnderungen €iNES ODBJEKLS ...........cceeeuuuie ettt ettt e e e e ettt e e e e e attaaaaaeseees 34
SPIEGEIN ..ottt 34
D= (=TI o =T = | o 34
Spiegeln an einer beliebigEN ACRNSE ...........cceee ettt 35

In einen 3D-RotationsSKOrper UMWaNAEIN ................coooiiiiiieiieeeeee e 36
Drehen des ROAHONSKOIPELS .........uuuee ettt ettt e e e ettt e e e et e e e te e et e et e e aaaeesen 37

4 Anderung der Objekteigenschaften



Setzen auf Kreis (DErSPEKLIVISCR) ........coooeeeeee ettt 37

Setzen auf KreiS (SCAFAQ STEIIEN) .........c.ccoe oottt e e e e e 38
VIBIZEITOIN ..ottt ettt ettt ettt 39
UMWENGEIN ...ttt ettt e sttt ettt e e e e e e e e e e e e s s s s e e e e e e eennae 40
Umwandeln in KUurven 0der POIYGONE ...........ouwwuuuiiii ettt 41
Art der UMWANAIUNG ..........ccooeeeeeeeeeee ettt e e e e e e e eenanns 41
Bearbeitung des umgewandelten ODJEKLS ...............ccovveeeuuiiiiee e e e eeeeeeesssaa e 41
Umwandeln in ein dreidimensionales ODBJEKL ...............uuwreeeiiiiiiiiiiieieeeeeeere e 44
Umwandeln in 3D-ROAHONSKOIPEL ............vvueueeeieeeee ettt e e e e e eeaaaaaan 45

TN BTG ...ttt e ettt 45

LY =] = 45

Anmerkung ftir Macintosh Nutzer 5



Einfiihrung

Dieses Kapitel behandelt Anderungen an Zeichnungsobjekten, die iiber die Anderung von Hohe
und Breite hinausgehen. Dies sind zum Einen Veranderungen der optischen Erscheinung wie
Farbe und Muster, die sogenannte Formatierung, zum anderen Anderungen der Form des Objekts.
Der Umgang mit dem Text eines Objekts wird in einem eigenen Kapitel 9 — Hinzuftigen und
Formatieren von Text dieses Handbuchs behandelt.

Formatierung

Wir beschreiben zunachst die direkte Formatierung von Zeichnungsobjekten. Sie haben auch die
Mdglichkeit, Formatvorlagen einzusetzen, in denen die gewlinschten Formatierungen festgelegt
sind; durch einfache Zuweisung der Formatvorlage zu einem Zeichnungsobjekt erhalt dieses alle
Formatierungen, wie sie in der Formatvorlage definiert sind. Dies kann z. B. von Vorteil sein, wenn
Sie mehrere Zeichnungsobjekte mit der gleichen Formatierung bendtigen. Wenn Sie die Format-
vorlagen noch in Dokumentenvorlagen ablegen, stehen Sie sogar dokumentiibergreifend zur
Verfugung.

Der Einsatz von Formatvorlagen wird in ,Formatvorlagen” auf Seite 30 beschrieben.

Formatieren von Linien

Dieser Abschnitt betrifft sowohl eigenstandige Linien wie einzelne Geraden, Kurven oder offene
Polygone wie auch die Rander flachiger Zeichenobjekte. Viele der im Folgenden beschriebenen
Eigenschaften treffen fur alle Linien zu, manche nur fiir einige.

Es gibt mehrere Mdglichkeiten, die Eigenschaften einer Linie zu verdndern, manche sind direkter
zu erreichen als andere, dafir bieten sie aber eventuell nicht den vollen Funktionsumfang. Sie
werden in den folgenden Abschnitten beschrieben.

Andern des Standards fiir die Linie

Wenn Sie ein Zeichnungsdokument 6ffnen, dann sind die Linieneigenschaften auf den Standard
eingestellt, den LibreOffice mitbringt, derzeit ist das z. B. eine blaue Linienfarbe und die Linienbrei-
te 0,00 cm. Sie kénnen fir alle Linieneigenschaften den Standard andern, indem Sie, wenn kein
Zeichnungsobjekt selektiert ist, die Eigenschaft auf den gewlinschten Wert andern, sofern die
entsprechenden Steuerelemente dann sichtbar sind, was nicht in allen Formen der Benutzerober-
flache der Fall ist. Sie wird dann mit diesem Wert fir alle zukiinftigen Linien verwendet.

Welche Standards eingestellt sind, kdnnen Sie vollstandig nur tber den Dialog Linie (s. ,Der Dialog
Linie" auf Seite 9) nachsehen, wenn Sie ihn aufrufen, ohne dass ein Zeichnungsobjekt selektiert
ist. Die Standards fur Linienstil, -breite und Schatten sind auch an den Symbolen erkennbar, wenn
kein Zeichnungsobjekt ausgewahlt ist.

Eine Ausnahme bildet der Schatten, denn der Reiter Schatten wird nur angeboten, wenn eine
Linie selektiert ist, dann aber wird die Einstellung fiir diese Linie gezeigt. Die Standard-Einstellung
fur den Schatten kénnen Sie nur einsehen Uber Format » Fléache... » Schatten, sie gilt fir
Flachen und Linien gleichermalZen.

Die Symbolleiste Linie und Fiillung

Abbildung 1 zeigt einen Ausschnitt dieser Symbolleiste mit den fur Linien relevanten Symbolen.
Wenn die Symbolleiste nicht sichtbar ist, kdnnen Sie sie tber den Menupfad Ansicht »
Symbolleisten » Linie und Fillung anzeigen.
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Abbildung 1: Symbolleiste Linie und Fiillung (Ausschnitt)

* Beim Symbol Linienstil kbnnen Sie neben der standardméRig verwendeten durchgezogenen
Linie aus einem Angebot verschiedener punktierter und gestrichelter Linienformen wahlen.

« [inienbreite bietet ein Drehfeld, mit dem Sie die Strichstarke einstellen kbnnen; auch die
Linienbreite 0,00 cm wird Ubrigens gedruckt, sie benennt die sogenannte ,Haarlinie®, die
dunnste Linie, die das Ausgabemedium darstellen kann.

» Das Symbol Linienfarbe zeigt in seinem unteren Teil die gerade aktive Farbe fir Zuweisungen
(nicht fur neue Linien!). Wenn Sie eine Linie ausgewdahlt haben und dann direkt auf das Symbol
klicken, wird der Linie diese Farbe zugewiesen.

Wenn Sie das Dreieckssymbol rechts daneben betéatigen, wird eine Abreil3leiste gedffnet, in der
Sie eine andere Farbe auswéhlen kénnen. Da diese auch fur Flachen und Zeichen verwendet
wird und einer ausfihrlichen Erklarung bedarf, wird sie in einem eigenen Abschnitt beschrieben
(s. ,Farben® auf Seite 14).

Auch wenn Sie eine vorhandene Linie oder ein flachiges Objekt selektieren, wird nicht die Farbe
der vorhandenen Linie gezeigt; dies ist ein Unterschied zum Verhalten bei Flachen. Wenn Sie
die die Farbe der Linie sehen wollen, missen Sie den Dialog 6ffnen und ggf. dort auch noch die
Farbauswahl.

Auch die Symbolleiste Zeichnung bietet ein Symbol gleichen Aussehens fiir die
Linienfarbe an. Die beiden Symbole sind nicht synchronisiert! Das kann verwirren,
aber auch ein Vorteil sein, da man auf diese Weise zwei verschiedene Farben per
einfachem Klick zuweisen kann.

Hinweis

« Uber das Symbol Schatten kénnen Sie die Anzeige eines Schattens einschalten, was bei Linien
eher die Ausnahme sein dirfte, denn der Schatten ist hier eine parallele Linie. Die Eigenschaf-
ten des Schattens kénnen Sie nur Uber den Format-Dialog (s. ,Der Dialog Linie* auf Seite 9)
beeinflussen.

* Mit dem Symbol Linienspitzen kénnen Sie getrennt fir den Anfang und das Ende einer Linie die
Form des Endes der Linie (vor allem verschiedene Pfeilformen) wéhlen. Die Grol3e der Spitze
wird dabei in Abhangigkeit von der Linienstarke gesetzt. Eine Grof3en&nderung der Linienspitzen
ist nur Gber den Format-Dialog (s. ,Der Dialog Linie" auf Seite 9) moglich.

Die Seitenleiste

Die Seitenleiste — einschaltbar Giber Ansicht » Seitenleiste oder Strg+F5 — bietet Steuerelemen-
te an fur den Linientyp, die beiden Linienenden, die Linienbreite, die Linienfarbe und die Trans-
parenz der Linie. Bei der Linienbreite wird zunachst nur eine kleine Auswahl vorgegebener Linien-
breiten angeboten, aber unterhalb dieser vorgegebenen Linienbreiten befindet sich auch noch ein
Kombinationsfeld, in dem Sie sowohl aus einer Liste Werte auswahlen als auch selbst einen Wert
eingeben kdnnen.

Da die Seitenleiste nur dann die Eigenschaften einer Linie anbietet, wenn eine Linie oder ein
Objekt, das von einer Linie begrenzt wird, angezeigt wird, ist es Uber sie nicht méglich, den
Standard flir neue Linien zu andern.
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Benutzeroberflachen-Varianten

Alternativ zur klassischen Darstellung mit Meni und Symbolleisten kdnnen Sie auch unter ver-
schiedenen Varianten der Darstellung mit Symbolbandern wahlen Gber Ansicht »
Benutzeroberflache. Stellvertretend wird hier die Variante In Registern dargestellt, die anderen
Varianten sind ahnlich.

Wenn kein Zeichnungsobjekt ausgewahlt ist, ist das Register Start (Abbildung 2) aktiv. Im linken
Teil dieses Registers kénnen Sie dann Standardwerte setzen, die flr neu zu zeichnende Linien
verwendet werden. Dies betrifft den Linienstil, die Linienbreite und die Linienfarbe; und der
Linienspitzen (ganz rechts in der Abbildung); auRerdem kdnnen Sie die Vorlagen-Seite der
Seitenleiste aufrufen. Der Text ,Linie" ermdglicht den Aufruf des Dialogs Linie (s. ,Der Dialog Linie"
auf Seite 9), in dem Sie weitere Standards setzen kénnen.

Die rechte Seite ermdglicht es, eine neue Linie einzufligen, entweder mit dem linken Symbol direkt
eine Linie ohne besondere Linienspitzen oder mit dem rechten Symbol eine der angebotenen
Varianten (die dann nochmals u. a. die einfache Linie enthalten).

Standards: Linientyp  Linienbreite Linienfarbe

[ate Start n?dqu L'-/ dnderungen Artgec £

= e

,J?ﬁ Linie... = 0,00 em = - -
h’arlaqen ""\ Farbe re — v Teatfedd v ertdiaber 'r-f/:| \ / -
N / /

Vorlagen Dialog Linie Einflugen: Linie Linien und
einfligen Linienspitzen

Abbildung 2: In Registern: Register Start
Wenn dagegen ein — gerade erzeugtes oder schon langer vorhandenes — Zeichnungsobjekt selek-
tiert ist, wird das Register Zeichnen (Abbildung 3) aktiviert, das im linken Teil die Steuerelemente
fur den Linienstil, die Linienbreite, die Linienfarbe und die Linienspitzen zeigt. Hier zeigen sie aber
die Eigenschaften der selektierten Linie an und dienen dazu, diese zu verandern; insbesondere
|6st Linien und Linienspitzen ein anderes Menu aus als im Fall des Registers Start, es werden
getrennt fur Anfang und Ende alle verfiigbaren Formen der Spitzen angeboten.

Linientyp  Linienbreite Linienfarbe Linienspitzen

Start finfy Ut Andery X\ bt Yeichnen Exterson Extran pewees

Linie... « 0,00cm > - v Zeichnen ¥

|
. i ; a
b LY e Farte r' e - I:l ' i . ola
ri _

Dialog Linie Schatten Dialog Dialog Position
Linie und Grofie

'l

Abbildung 3: In Registern: Zeichnen

Im rechten Teil kbnnen Sie den Dialog Linie (s. ,Der Dialog Linie* auf Seite 9) und den Dialog
Position und Gréf3e (s. Kapitel 3 dieses Handbuchs) aufrufen, um weitere Linieneigenschaften zu
setzen. Den Dialog Linie kénnen Sie auch wieder durch Anklicken des Texts ,Linie* aufrufen.
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Auch wenn Sie selbst das Register Start wahlen, beeinflussen die Eingaben die
selektierte Linie und nicht den Standard.

Hinweis
Der Dialog Linie

Den vollstdndigen Umfang aller Eigenschaften kénnen Sie im Dialog Linie anzeigen und andern,
den Sie Uber folgende Wege erreichen kdnnen:

e Format » Linie...
* Kontextmenii » Linie...
* den Abschnitt Linie im Blatt Eigenschaften der Seitenleiste

* wenn die Benutzeroberflache auf In Registern eingestellt ist: durch Klicken auf das Wort
.Linie" in der Registerkarte Start

* wenn die Benutzeroberflache auf In Registern kompakt eingestellt ist: durch Klicken auf das
Wort ,Linie" in der Registerkarte Start

* wenn die Benutzeroberflache auf kontextabhédngig kompakt eingestellt ist: durch Klicken
auf das Wort ,Linie" oder das Symbol mit drei untereinander angeordneten Punkten rechts
von den Symbolen fir die Linie

Er besitzt bis zu vier Registerkarten.

Die Registerkarte ,Linie*

Diese Registerkarte enthalt neben den bereits bekannten Steuerelementen fir Linienstil, -breite, -
farbe und -spitzen weitere fiir die Breite der Linienspitzen und fir die Transparenz der Linie; je
hoéher die Transparenz ist, umso starker scheint der Hintergrund durch.

Bei den Linienspitzen gibt es noch Markierfelder mit der Bezeichnung zentriert. Die Wirkung zeigt
Abbildung 4:

o =] B e |
o = e H
o =] ]

Abbildung 4: Zentrierung der Linienspitzen (unten)

Bei den linken orangenen Linien sind die unteren Enden zentriert, die oberen nicht, die vier blauen
Quadrate an den Ecken des Selektionsrechtecks der beiden Linien markieren die logischen
Endpunkte der idealen Linien, die ja konzeptionell ein eindimensionales Gebilde sind, man sieht
hier deutlich, dass die Endsymbole der Linie im unteren Fall zentriert um den Endpunkt gezeichnet
sind, im oberen Fall enden sie von innen am Endpunkt der Linie.

Das mag fur freie Linien keinen grofRen Unterschied bedeuten, aber bei Verbindern (s. Kapitel 8 —
Verbinder, Fluss- und Organisationsdiagramme dieses Handbuchs), die ja auch Linien sind, die
aber die zusatzliche Moglichkeit des Einrastens an Objekt- und Klebepunkten haben, kann das
wichtig sein. Der rechte Teil von Abbildung 4 zeigt oben einen Verbinder, der nicht zentriert ist,
unten einen zentrierten. Wenn man erreichen mdchte, dass die sichtbare Pfeilspitze in das
Rechteck hineinragt, dass aber trotzdem der Verbinder auch bei Verschieben des Rechtecks mit
diesem verbunden bleibt, dann ist die Zentrierung eine einfache Methode.
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Die Registerkarte enthalt auch noch Auswabhllisten fiir Linienecken- und Linienenden-Stil, die beide
unabhangig voneinander und deshalb auch beliebig kombinierbar sind. Die Auswahlmaoglichkeiten
und ihre Wirkung kann man in Abbildung 5 ersehen:

Abgerundet - kein - Gehrung \ Abgeschréagt \
i

Rechteckig Grolien-

(kein Eckenstil) vergleich

Flach- -
Rechteckig

Flach
(mit abgerundet)

Rund
(mit Gehrung)

Abbildung 5: Linienecken (oben) und -enden (unten)
Auch hier ist die Wirkung deutlicher zu sehen, wenn die Linien breiter sind.

Die Linienecken wirken sich dann aus, wenn die ,Linie" aus mehreren Segmenten besteht, also
Z. B. bei solchen, die man mit einem der Polygon-Werkzeuge zeichnet, aber auch bei zweidimen-
sionalen Zeichnungsobjekten mit Ecken (Dreiecke, Rechtecke usw.) und Verbindern. Die obere
Reihe in Abbildung 5 zeigt die vier Varianten fur die Linienecken.

Die untere Reihe zeigt zun&chst in den linken drei Fallen die Varianten fir die Linienenden. Die
Optionen Rund und Rechteckig fiigen jeweils einen Halbkreis oder ein halbes Quadrat (in einer der
Linienbreite angepassten GroR3e) an die Linie an, was die Linie etwas langer aussehen lasst. Das
rechte Bild zeigt als Beispiel die Ubereinandergelegten Falle fir Flach (in gelb) und Rechteckig,
man erkennt deutlich die grol3ere Lange der dargestellten Linie in Form des schwarzen
Halbquadrats.

In der unteren Reihe ist aulRerdem jeweils ein anderer Linieneckenstil gewahlt, um die Kombination
der beiden Parameter zu zeigen. Beachten Sie, dass im dritten Beispiel die Ecke nicht wie im
zweiten Fall der oberen Reihe aussieht, sondern sich die beiden angefligten Halbquadrate
Uberschneiden.

Die Wahl der Linienenden beeinflusst auch die Darstellung einer nicht durchgangigen Linie.
Abbildung 6 verdeutlicht das anhand des im Standard mitgelieferten Linienstils ,Fein gestrichelt":
die Enden jedes Abschnittes der unterbrochenen Linie werden in den unteren beiden Fallen durch
einen Halbreis bzw. ein Halbquadrat verlangert.

Abbildung 6: Fein gestrichelte Linie mit verschiedenen Linienenden

Die Registerkarte ,,Schatten*

Diese Registerkarte ist nur vorhanden, wenn ein ,eindimensionales” Objekt wie eine Linie oder
eine Kurve oder ein Verbinder selektiert wurde.
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Sie kdnnen hier festlegen, ob Uberhaupt ein Schatten dargestellt werden soll, und dessen Position
relativ zum Zeichnungsobjekt (nach oben, unten, links, rechts, in den vier diagonalen Richtungen) ,
die Distanz zu diesem, die Schattenfarbe und deren Transparenz bestimmen.

Die Registerkarte ,Linienstile*

Hier kdnnen Sie Linienstile &ndern oder neue definieren. Der wichtige Punkt ist, dass, wie der
Name Stil schon nahelegt, die Anderung nicht fiir die gerade selektierte Linie gilt, sondern
allgemein fur Draw.

Linie Schatten Linienstile Linienspitzen
Eigenschaften
Liniengtil: | ----- e dingbum V| Hinzufiigen
~P i Andern
Anzahl: 5 = ] =
= = Léschen
Linge: 0,05 cm = =
Abstand: 012em 5
[ An Linienbreite anpassen
E
o0, P
I R R R IR N R NN R N R R RNNNE R N N L NNNNNY * o > e
l\‘ !'.‘ t?% ""

Abbildung 7: Registerkarte "Linienstile”

Abbildung 7 zeigt einen neu definierten Stil, der von einem der von LibreOffice mitgelieferten
abgeleitet wurde. Die Anzahl der Striche und Punkte wurde verandert, und auch der Abstand
(zwischen den einzelnen Linien und Punkten).

Punkte und Striche sind hier beide Rechtecke, der Unterschied zwischen beiden besteht nur darin,
dass ein Punkt automatisch die Lange entsprechend der Strichstarke hat (weshalb dieses Feld fir
einen Punkt in Abbildung 7 auch leer bleibt), wahrend die Lange fur einen Strich festlegbar ist.

Wenn Sie solche Anderungen gemacht haben und die Schaltfliche OK betéatigen, haben Sie die
Wabhl, den fur diese Linie verwendeten Linienstil zu &ndern — was dann fir alle Dokumente eines
Benutzers gilt — oder einen neuen Stil zu definieren und ihm einen Namen zu geben, der nattrlich
auch systemweit gilt, aber zunéchst nur dem behandelten Objekt zugeordnet ist.

An Linienbreite anpassen

Abbildung 7 enthalt noch ein Ankreuzfeld An Linienbreite anpassen. Wenn Sie dieses Feld akiti-
vieren, bedeutet das, dass alle Angaben, die in absoluten Werten erfolgten, nun relativ zur
Linienbreite gelten sollen; deshalb werden sie in Prozentzahlen umgerechnet. Abbildung 8 zeigt
links die Angaben des mit LibreOffice ausgelieferten Standard-Linienstils, rechts die Werte nach
der Umstellung auf die Anpassung auf die Linienbreite; der Linienstil hat einen neuen Namen, weil
sich das beim Verwalten fast zwangslaufig so ergibt.
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Linienstil: Linienstil:

Typ: trich w | |Strich ~ | Typ: rich w | |Strich w

Anzahl: 2 = 3 = Anzahl: 2 = 3 =
Lénge: 0,51 mm = 1254 mm = Lange: % = 169 % =
Abstand: <‘.%E{> 1,27 mm = Abstand: 4% =

[ An Linienbreite anpassen An Linienbreite anpassen

Abbildung 8: An Linienbreite anpassen: Absolute und relative Angaben

Abbildung 9 zeigt in der oberen Halfte oben eine Linie mit der Starke 3,5 mm, die mit dem in
Abbildung 8 links gezeigten Stil gezeichnet wurde; direkt darunter befindet sich die gleiche Linie,

nun aber mit dem Linienstil Linienstil1 aus der Abbildung 8, Sie sehen, dass die Linie gedehnt
wurde.

Abbildung 9: Auswirkung von "An Linienbreite anpassen”

In der unteren Halfte dieser Abbildung sehen Sie die gleichen beiden Linien, aber mit einer Starke
von nunmehr 2 mm. Die obere Linie hat sich ihrer Breite verandert, was sich in diesem Fall als
Hohe zeigt, die Abstande und Langen der einzelnen Abschnitte ist allerdings gleich geblieben.

Anders bei der unteren Linie: die Langen und Absténde haben sich verringert, proportional zu der
Linienbreite.

Punktierte Linien

Wie schon oben gesagt, ist das, was als Typ Punkt bezeichnet wird, in Wirklichkeit ein Rechteck,
dessen Breite der Linienbreite entspricht, also ein Quadrat. Das féllt bei feinen Linien nicht auf, bei
grolRerer Strichstarke wie in Abbildung 10 oben allerdings schon.

Abbildung 10: Normale punktierte Linie und runde Punkte

Mit einem kleinen Kniff kénnen Sie fast runde Punkte erzeugen: Wahlen Sie (Abbildung 11) einen
Strich mit Lange 0,01 cm (wenn Sie 0 cm wéahlen, wird er automatisch zum Punkt, damit ist nichts
gewonnen) und einen nicht zu geringen Abstand.
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Typ: Strich w | |F'un|cte w

Anzahl: 1 = |0 =
Linge: 0,01 em = =
Apctand: 0,70 cm =

[ An Linienbreite anpassen

Abbildung 11: Einstellungen des Linienstils fiir fast runde Punkte

Speichern Sie den Linienstil unter einem passenden Namen.

Wahlen Sie auf3erdem fur die Linie den Linienendenstil abgerundet; dass sich zwischen den zwei

Halbkreisen ein schmales Rechteck von 0,01 cm Breite befindet (Abbildung 11), fallt praktisch nicht
auf.

Die Registerkarte ,Linienspitzen

Diese Registerkarte dient weniger dem Zuordnen von Linienspitzen zu einer Linie — denn die Zu-
ordnung erfolgt hier immer parallel auf beiden Seiten, getrennt geht das besser tber die Register-
karte Linie — , sondern der Anderung bestehender oder der Definition neuer Linienspitzen.

Linie *

Linie Linienstile Linienspitzen

Linienspitzen verwalten I,\\,
Titel: KX :
Linienspitzen: [—# xxx ~ - %EE
Andern
Laschen
Meue Linienspitzen erhalten Sie durch Hinzufligen eines ausgewsdhlten Objektes. F"

"\

Abbildung 12: Definition einer Linienspitze

Abbildung 12 zeigt den Zustand, nachdem ein Zeichnungsobjekt als Modell flr die Linienspitze
erzeugt wurde (eine Ellipse, rechts in der Abbildung zu sehen) und dann Format » Linie »
Linienspitzen gewahlt wurde und im darauf automatisch folgenden Dialog der Name ,xxx*

vergeben wurde. Beachten Sie, dass die Ellipse im Original waagrecht liegt, aber senkrecht
verwendet wird.

Wenn Sie nun in diesem Dialog die (nicht abgebildete) Schaltfliche OK betétigen, wird die neue
Linienspitze gespeichert.

Den Dialog kénnen Sie auch nutzen, um bestehende — egal, ob von LibreOffice ausgelieferte oder
von lhnen definierte — Linienspitzen zu andern oder zu Idschen.
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Linienstil- und Linienspitzentabellen

Die Registerkarten fur Linienstile (Abbildung 7) und Linienspitzen (Abbildung 12) enthalten rechts
unten jeweils Symbole fur das Laden und das Sichern einer Datei. Damit kénnen Sie von Ihnen
erstellte Linienstile und Linienspitzen, die zunéchst nur im Dokument gespeichert sind, fir andere
Dokumente zur Verfligung stellen.

Tabelle sichern

Mit dem Symbol Speichern werden die vorhandenen Definitionen der Linienstile oder Linienspitzen
in einer Datei mit einem von Ihnen zu vergebenden Namen an dem von lhnen angegebenen Ort
gespeichert; die Linienstile in einer Datei mit Endung .sod, die Linienspitzen mit Endung .soe.

Sobald Sie eine solche Tabelle gespeichert haben, ist das Dokument mit dieser
Vorsicht Tabelle verkniipft und nicht mehr mit der Standard-Tabelle der Linienstile oder
-spitzen von LibreOffice. Sollten Sie diese Tabelle spater &ndern, also z. B. iber-
A schreiben, ist auch dieses Dokument davon betroffen. Planen Sie also das
Speichern dieser Tabellen sorgfaltig.

Tabelle laden

Sie kdnnen eine vorhandene Tabelle der Linienstile oder der Linienspitzen in das Dokument laden.
Diese Tabelle ersetzt die bisher verwendete Tabelle, die in der Regel die Standardtabelle von
LibreOffice sein durfte.

Sobald Sie eine solche Tabelle geladen haben, sind nur noch die Definitionen der
Vorsicht Tabelle verfugbar. Vorhandene Linien behalten zwar ihre Stile und Linienspitzen,
auch wenn sie nicht mehr in der Tabelle vorhanden sind, aber Sie kdnnen diese Stile
A oder Spitzen nicht mehr fir neue Objekte vergeben. Selbst die Gré3enangaben des
Stils sind nicht mehr verfiigbar.

Farben

Vielen Objekten in Draw kann eine Farbe zugewiesen werden. Dazu gibt es verschiedene Wege:
e Uber die Menus

o Format » Zeichen fiir Schriftfarbe, Farbe fiir Hervorhebungen, der Uber- und der
Unterstreichung

o Format » Flache fir die Flachen- und die Schattenfarbe und die Farben fiir einen
Farbverlauf (s. ,Das Blatt ,Farbverlauf* auf Seite 22)

o Format » Linie fur die Linienfarbe
o die Kontextmenus der Objekte
* Uber die Symbolleisten
o Linie und Flllung fir Linien- und Flachenfarbe
o Textformat fur Schriftfarbe und Farbe fiir Hervorhebungen
e (ber die Farbleiste (s. ,Farbleiste und Farbpalette” auf Seite 17)

und wenn man eine andere als die (in manchen Fallen) vorgeschlagene wahlen will, wird immer
die Farbfestlegung (s. den folgenden Abschnitt) angezeigt, manchmal als Abrei3leiste, aber auch
— bei der Flache — als integrierter Bestandteil eines grél3eren Blattes, das in ,Das Blatt ,Farbe* auf
Seite 21 néher behandelt wird.
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Farbfestlegung

Abbildung 13 zeigt die Farbfestlegung am Beispiel der Linienfarbe Giber die Symbolleiste Linie und
Fiillung.

2] | e

Linienfarbe

|5tar||:|aru:| V|

Fuletzt verwendet

[ Benutzerdefinierte Farbe...

Abbildung 13: Farbfestlegung
Die Abreil3leiste hat je nach Kontext einen unterschiedlichen Titel!

Im Zentrum steht die 10 x 12 Farbflachen anzeigende Tabelle, aus der Sie durch einfaches Anklic-
ken eine der vorgeschlagenen Farben auswahlen kénnen.

Welche Farben dort angeboten werden, hangt von der gewdahlten Farbpalette ab, die in der Aus-
wahlliste oberhalb der Farbtabelle angezeigt wird (hier ,Standard”). LibreOffice bringt schon bei der
Installation neben der Palette ,Standard” einige spezielle Paletten mit, aul3erdem eine besondere
mit dem Namen ,benutzerdefiniert, in der Sie lhre eigene Zusammenstellung von Farben ablegen
kénnen. Dies ist allerdings Uber die hier behandelte Farbauswahl nicht méglich, sondern nur Gber
den Umweg der Formatierung einer Flache (die Sie dann aber abbrechen kénnen); lesen Sie dazu
.Der Dialog Flache" auf Seite 21.

Unterhalb der Farbtabelle werden unter der Uberschrift Zuletzt verwendet die letzten 12 Farben
angeboten, die Sie Zeichnungsobjekten zugewiesen haben, egal, um welchen Objekttyp es sich
handelte. So kénnen Sie bequem eine Farbe erneut zuweisen.

Wenn die Farbe aus einer Palette gewahlt wurde, zeigt die Direkthilfe (Zeigen mit der Maus auf die
Farbflache) den Namen der Farbe, wie er bei der Definition der Palette vergeben wurde, wenn Sie
selbst eine Farbe bestimmt haben, wird der Hexadezimalcode der Farbe in der RGB-Darstellung
(s. ,Der Dialog Farbauswahl* auf Seite 16) angezeigt.

Wenn die angebotenen Farben nicht die von Ihnen gewiinschte enthalten, kdnnen Sie Uber die
Schaltflache benutzerdefinierte Farbe... den Dialog Farbauswahl aufrufen, der im nachsten
Abschnitt beschrieben wird.
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Der Dialog Farbauswahl

In diesem Dialog (Abbildung 14) kénnen Sie eine beliebige Farbe definieren, die mit den
implementierten Verfahren darstellbar ist.

Farbauswahl >

RGB
O Rot: h2s -
) Griin: 170 =
) Blau: 227 =
Hex &: Tdaae3
s [
HSB

O] Farbton: 214° =
(O sattigung: |45 % =
o O Helligkeit: [89% >

CMYK
Cyam: 45% =
I Magenta: 25% -
Gelb (Yellow): |0% =
B - -
Hilfe QK Abbrechen

Abbildung 14: Dialog Farbauswahl

LibreOffice bietet hier gleichzeitig drei gebrauchliche Varianten an, die ineinander umgerechnet
werden konnen (vertiefte Informationen finden Sie im Internet):

e RGB: die Farben werden definiert durch das AusmalfR, in dem sie Anteile der drei Grundfar-
ben Rot, Griin und Blau enthalten. Jeder der drei Variablen kann die Werte 0 bis 255 an-
nehmen. Diese Grenzen lassen schon erahnen, dass die eigentliche Definition tGber hexa-
dezimale Zahlen erfolgt, dass also die Werte in hexadezimaler Darstellung aus zwei Stellen
bestehen. Die knappe Darstellung im Feld ,Hex #“ reiht einfach die drei zweistelligen
LZahlen“ hintereinander. Die Definition einer Farbe tiber die Rot-, Griin- und Blau-Anteile
wird intern in LibreOffice fir die Darstellung auf dem Bildschirm verwendet.

* HSB: Eine alternative gebrauchliche und fur die Praxis einfacher zu verwendende Vorge-
hensweise ist die Bestimmung der Farbe Uber Helligkeit, Sattigung und Farbton. Die Ab-
klirzung leitet sich von den englischen Bezeichnungen Hue (Farbton), Saturation (Satti-
gung) und Brightness (Helligkeit) her. Es ist einfacher, zun&chst grundsatzlich die Farbe
auszuwahlen und dann tUber die Sattigung die Bedeutung der Farbe gegeniiber dem neu-
tralen Grau und die Helligkeit festzulegen; dies geschieht so auch Uber die Farbflachen im
linken Teil des Dialogs, die weiter unten besprochen werden.

Helligkeit und Sattigung werden dabei als Prozentzahl angegeben, der Farbton als Grad-
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Angabe zwischen 0° und 360°, weil dem Modell ein Farbkreis zugrunde liegt.
LibreOffice rechnet diese Werte in die RGB-Werte um, mit denen es intern arbeitet.

* Die CMYK-Darstellung der Farbe wird beim Druck verwendet. Der Druck arbeitet mit einem
subtraktiven Modell, d. h. wenn keine Farbe gedruckt wird, erscheint weil3, die Farbe des
Papiers, wahrend am Bildschirm Weil3 als Summe aller drei Primarfarben erzeugt wird, was
ein additives Verfahren ist. Das CMYK-Modell arbeitet mit den vier Komponenten Cyan,
Magenta, Yellow und Key (Schwarz).

LibreOffice rechnet diese Werte in die RGB-Werte um, mit denen es intern arbeitet.

Sie haben somit die Mdglichkeit, die Farbe je nach lhren Erfordernissen zu definieren. Die erste
und dritte Variante dirfte eher durch Forderungen von auf3en bendtigt werden, die mittlere ist in
vielen Féllen die am leichtesten verstandliche.

Die Handhabung des Dialogs ist nicht ganz selbstverstandlich, sie wird zunéchst im Fall HSB, wo
die verwendeten Parameter am ehesten mit der sichtbaren Realitat in Verbindung gebracht werden
konnen, erlautert, anschlieRend dann fiir die anderen Falle ergénzt.

HSB

Der Dialog bietet bei dieser Auswahl drei Parameter an; einer wird als primarer Parameter durch
eine lineare Schaltfliche reprasentiert; im Standard ist das, wie in Abbildung 14 zu sehen, der
Farbton, der rechts in einer schmalen senkrechten Flache dargestellt wird, die eine lineare
Abstufung reprasentiert, die anderen beiden definieren links eine Farbflache, die je nach Auswahl
des priméren Parameters unterschiedliche Anzeigen bietet; in der Abbildung steigt die Sattigung
von links nach rechts, die Helligkeit nimmt von oben nach unten ab.

Probieren Sie auch die anderen beiden Varianten aus, vielleicht sagt Ihnen eine andere besser zu.

Bei der linken Flache kénnen Sie den Kreis mit der Maus verschieben, um die Anteile der Kompo-
nenten Helligkeit und Sattigung einzustellen, bei der rechten kénnen Sie lber den durch die Zeiger
links und rechts angedeuteten Schieber den Farbton wahlen, indem Sie an der gewlinschten Stelle
in das Feld klicken. Alternativ kdnnen Sie natirlich die Werte im Abschnitt HSB direkt &ndern.

Das Ergebnis einer Anderung, egal mit welchen Mitteln Sie sie vorgenommen haben, wird in den
zwei Flachen unterhalb der groRen Farbflache fur Sattigung und Helligkeit angezeigt: die linke
zeigt die neue Farbe aufgrund lhrer Anderungen, die durch OK dann zugewiesen wurde, die rechte
zeigt die bisher benutzte Farbe.

Durch die Betatigung der Schaltflache OK wird der Dialog geschlossen, die Farbe wird in das
entsprechende Feld des rufenden Dialogs Ubertragen.

RGB

Die Vorgehensweise ist die gleiche wie bei HSB, allerdings ist das Verhalten schwieriger zu
verstehen,denn durch eine Verschiebung des durch einen Kreis markierten Punktes im linken Feld
andert sich auch die Abstufung im rechten linearen Feld, das ja jeweils die Farben zeigt, die sich in
Kombination des veranderlichen primar gewahlten Farbanteils mit den durch die Position des
Kreises fixierten Anteilen der beiden anderen Farben ergeben.

Farbleiste und Farbpalette

Eine weitere Mdglichkeit, die Farben von Objekten zu beeinflussen, bietet die Farbleiste. Sie
kdnnen sie aktivieren und deaktivieren Gber Ansicht » Farbleiste.

Meist wird die Farbleiste dann unterhalb des Arbeitsbereichs und unterhalb des Balkens zur Hand-
habung der Ebenen angezeigt (Abbildung 15).
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Abbildung 15: Farbleiste

Sie konnen die Farbleiste ein- und ausblenden Gber den Mittelteil des schmalen Balkens im Kopf
der Farbleiste.

Die Farbleiste zeigt in diesem Zustand nur wenige Farben direkt an, weitere sind nur durch Rollen
verflgbar.

Wenn Sie im Bereich des Kopfbalkens der Farbleiste die Maustaste driicken und dann den Cursor
bewegen, kénnen Sie die Grolie der dargestellten Farbleiste beeinflussen, dadurch sind mehr
Farben direkt auswahlbar.

Zuweisung von Farben
1. Wabhlen Sie eine Form oder einen Text aus

2. Kilicken Sie mit der linken Maustaste auf eine Farbe: - die Flachenfarbe bzw. die Textfarbe
wird gedndert

3. Klicken Sie mit der rechten Maustaste auf eine Farbe: - die Linienfarbe wird geandert
Gegebenenfalls wird auch eine bisher nicht sichtbare Flache oder Umrandung erst eingeblendet.

Die Flachenfarbe kénnen Sie auch durch Ziehen der Farbe mit der Maus auf das gewlinschte
Objekt zuweisen.

Ohne Maus konnen Sie Flachen oder Textfarbe setzen, indem Sie sie mit den Pfeiltasten
auswahlen.

Farbpalette

Durch Abreif3en der Symbolleiste Farbleiste kbnne Sie die Farbpalette erzeugen, die die gleichen
Informationen enthalt wie die Farbleiste, aber frei verschiebbar ist. Zum Abreil3en klicken Sie in
den freien Bereich der Farbleiste und ziehen dann mit der Maus den Fokus irgendwo anders hin,
wenn Sie die Maustaste loslassen, wird die Farbpalette dort angezeigt.

Um die Palette wieder anzudocken, doppelklicken Sie bei gedriickter Strg-Taste in den grauen
Bereich rund um die Farben; bei der Titelleiste der Palette hat dieses Vorgehen keine Auswirkung.
Sie kdénnen die Palette jedoch auch wie andere Fenster andocken, der Bereich, in dem dies
mdglich ist, ist jedoch gerade am unteren Rand recht klein.

Formatieren von Flachen

Wenn wir hier die Formatierung einer Flache behandeln, geht es immer um den inneren Teil einer
Flache, der Rand der Flache wird als Linie betrachtet, der somit Uber die entsprechenden
Linienfunktionen (s. ,Formatieren von Linien“ auf Seite 6) zu formatieren ist. Wenn Sie also den
Rand eines Rechtecks formatieren wollen, verwenden Sie also (bei selektiertem Rechteck) Format
» Linie..., Kontextmenii » Linie..., Seitenleiste » Linie oder die entsprechenden Symbole.

Eine Flache kann eine Vielzahl von — teilweise voneinander abhangigen — Eigenschaften besitzen.
In dieser Ubersicht werden nur die bestimmenden Eigenschaften aufgefuhrt, die Details werden
spater erlautert.

* Fillung: eine Flache kann auRer mit einer Farbe auch mit Farbverlaufen, Bildern und
Mustern gefiillt werden:
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* ohne: das Objekt besitzt keine sichtbare Flache, mdglicherweise einen Rand und einen
Text; ohne beide ist es, aul3er in Sonderfallen, sinnlos

* Farbe: das Objekt besitzt eine einheitliche Farbe

* Farbverlauf: fir das Objekt sind zwei Farben definiert, die die Flache in
unterschiedlicher Weise mit allen ihren Ubergéangen fiillen; eine einfihrende
Beschreibung finden Sie in ,Das Blatt ,Farbverlauf* auf Seite 22

e Schraffur: die Flache wird mit Linien bedeckt, die sich ein-, zwei- oder dreifach
kreuzen. Naheres finden Sie in ,Das Blatt ,Schraffur* auf Seite 27.

* Muster: die Flache wird mit einem Muster gefillt, das sich aus Punkten
zusammensetzt. Dieses Muster konnen Sie in einem 8 x 8-Raster definieren, s. ,Das
Blatt ,Muster* auf Seite 27.

* Bild/Bitmap: Hier konnen Sie von LibreOffice zur Verfigung gestellte oder selbst
importierte Grafiken verwenden, um die Flache zu fullen, N&heres unter ,Das Blatt
,Bild* auf Seite 25.

* Transparenz: Naheres finden Sie in ,Registerkarte ,Transparenz* auf Seite 28.
* Schatten: Details finden Sie in ,Registerkarte ,Schatten* auf Seite 27.

Die meist wichtigsten Eigenschaften einer Flache kénnen Sie auf abgekirztem Weg tber
Symbolleisten setzen, den vollstandigen Umfang bietet der Dialog Flédche, der in ,Der Dialog
Flache" auf Seite 21 beschrieben ist. Hier folgen zunéchst die direkten Zuweisungsmaoglichkeiten
Uiber Symbole/Steuerelemente.

Wie bei der Linie gilt, dass die Anderungen den Standard betreffen, wenn kein Zeichnungsobjekt
selektiert, und das Objekt oder die Objekte, wenn es/sie selektiert ist/sind.

Symbol- und Seitenleisten

Anstatt des klassischen Menus kdnnen Sie Uber Symbolleisten auf einem oft direkteren Weg
ausgewahlte Funktionen erreichen. Dazu zahlt die klassische Symbolleiste Linie und Fiillung, die
Sie ggf. Uber Ansicht » Symbolleisten aktivieren kdnnen, die Seitenleiste, die Sie Uber Ansicht
» Seitenleiste einblenden kdnnen, und die alternativen Symbolbander, die Sie statt/zusatzlich zu
der klassischen Ansicht mit Ment und mehreren Symbolleisten wéhlen kénnen tber Ansicht »
Benutzeroberflache. Die Auswahl von Funktionen zur Formatierung ist dort in unterschiedlichem
Ausmal moglich. Anders als im Abschnitt fur Linien (s. ,Benutzeroberflachen-Varianten* auf Seite
8) gibt es hier allerdings kein Verstandnisproblem durch eine verschiedene Bedeutung des
gleichen Symbols, daher kann die Darstellung hier knapper ausfallen.

Abbildung 16 zeigt die maximal zur Verfigung stehenden Steuerelemente in den Symbolleisten,
die beiden folgenden Tabellen zeigen, welches Steuerelement in welcher Form der Benutzerober-
flache zur Verfliigung steht, je nachdem, ob ein Zeichnungsobjekt selektiert wurde oder nicht; der
Fall der Transparenz, die auRerhalb des Dialogs Flédche (s. ,Der Dialog Flache" auf Seite 21) nur in
der Seitenleiste zur Verfligung steht, ist ausgelassen.

Das dritte Element, das hier aus Farbeimer, Farbflache und dem nach unten gerichteten Dreieck
als Auswahlsymbol besteht, steht hier — als haufigster Fall — nur stellvertretend fur die verschiede-
nen Mdoglichkeiten einer Flachenfillung; weitere Mdglichkeiten sind Farbverlaufe, Schraffuren,
Bitmaps und Muster.

Bei der Auswahl Muster besteht derzeit ein Problem, das unter 128612 - ,Toolbars show wrong
area type for pattern and do not work correctly* bereits gemeldet wurde: nach der Zuweisung.eines
Musters wird anschlieend im Flachenstil ,Bitmap“ angezeigt, wenn man erneut Muster wahlt, geht
die Formatierung verloren. Verwenden Sie daher fiir die Zuweisung eines Musters konsequent den
Dialog, s. ,Der Dialog Flache" auf Seite 21.
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Dialog Hache Hachenfullung Dialog Hache

/ —

Fliche... [Farbe A - O ;o

Hachenstil Schatten Position & Grofle
Abbildung 16: Steuerelemente ftir die Fldche in Symbolleisten

Kein Objekt selektiert

Flche.. 2 -} | T} | ]| %]
Linie und Fullung - J J J - -
Seitenleiste - - - - - -
In Registern J J J - - -
In Registern kompakt J J J J J -
II((ontextabhanglg 3 3 3 3 3 i
ompakt
Gruppiert kompakt - - J - - -

Objekt selektiert

Flache.. o -| | O} | || &]

Linie und Fullung - J J J - J
Seitenleiste - J J * - *
In Registern J J J J - J
In Registern kompakt J J J J J J
Kontextabhéangig 3 3 3 3 3 i
kompakt

Gruppiert kompakt J J J J - -

*: stattdessen gibt es einen eigenen Abschnitt dafir

Transparenz in der Seitenleiste
In der Seitenleiste enthalt der Abschnitt Fldche auch Steuerelemente fir die Transparenz. Diese
sind abhangig von der Form der Transparenz (Abbildung 17).
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Transparenz: |Durchgﬁngig W Transparenz: |Lir1ear w

Fe——

I 50 %
Abbildung 17: Steuerelemente fiir die Transparenz in der Seitenleiste

* Ist keine Transparenz angegeben, dann sieht das Bild &hnlich wie im linken Teil aus, der
Eintrag im Feld Transparenz lautet ,Keine®, der Schieber zeigt einen Wert von 0 %.

* ist der Fall Transparenz gewahlt, dann sehen Sie eine Anzeige &hnlich wie im linken Teil

* |st dagegen ein Verlauf eingestellt, dann zeigt sich ein Bild wie im rechten Teil: das obere
Steuerelement zeigt den Typ des Verlaufs, das untere ermdglicht nach Anklicken die
Anzeige und Verwaltung der Werte Winkel, Startwert, Endwert und Umrandung. Fir den
Winkel sind sogar noch zusatzliche Schaltflachen vorhanden, die es erlauben, den Winkel
in Schritten von 45° im und gegen den Uhrzeigersinn zu drehen

Der Dialog Fléache
Die volle Kontrolle tber alle Eigenschaften erhalten Sie tUber diesen Dialog.

Der Dialog enthalt die drei Registerkarten Fldche, Schatten und Transparenz.

Registerkarte ,,Fldche“

Diese Registerkarte enthalt im Kopf sechs Schaltflachen, die wie Registerkarten auf einer zweiten
Ebene wirken und unterschiedliche Inhalte im weiteren Teil des Dialogs anzeigen; diese werden
hier als Blétter bezeichnet.

Fliche =

Fliche Schatten Transparenz

ighneé Farbe Farbwerlauf Bild Muster Schraffur

Abbildung 18: Kopf des Dialogs "Fldche" mit Registerkarten und Schaltflachen flir Blétter

Das Blatt ,,Ohne*
Hier kdnnen Sie nur festlegen, dass eine Flache keine Fullung besitzt.

Das Blatt ,,Farbe*“
Diese Registerkarte bietet im Vergleich zum Dialog Farbfestlegung (s. ,Farbfestlegung” auf Seite
15) erweiterte Moglichkeiten.

Uber die Schaltflache Auswéhlen... erhalten Sie den selben Dialog, wie er schon in ,Der Dialog
Farbauswahl" auf Seite 16 beschrieben ist. Aber Sie kénnen die gewiinschte Farbe in der RGB-
Darstellung hier auch direkt eingeben durch Veranderung der Werte der drei Farbkomponenten.
Die beiden Spalten rechts neben der Palette zeigen die Farbinformationen des derzeitigen Objekts
und ggof. die geanderten Werte fur dieses Objekt an. Eine Anderung tber den durch Auswéhlen...
aufgerufenen Dialog wird bei dessen SchlieRen mit OK in die rechte Spalte Neu Ubertragen.

Dies ist nun keine grof3e Erleichterung. Aber eine wirklich neue Funktionalitat bieten die beiden
Schaltflachen links unten unter der Uberschrift ,Palette anpassen®: Sie kdnnen die neu definierte
Farbe permanent zu lhrer Verfigung stellen, indem Sie auf Hinzuftigen klicken. Sie erhalten dann
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die Mdglichkeit, der Farbe eine Benennung Ihrer Wahl zu geben. Die Farbe wird dann automatisch
in der Palette ,Benutzerdefiniert“ gespeichert; Sie kdnnen die vordefinierten oder moglicherweise
durch eine Erweiterung geladenen Paletten nicht andern, daflr ist die zunachst leere Palette
.Benutzerdefiniert” vorgesehen.

Die so gespeicherte Farbe kdnnen Sie spater — auch fur Linien, Zeichen usw. — anwenden, indem
Sie die Palette ,Benutzerdefiniert” wéahlen.
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Abbildung 19: Farbverwaltung im Dialog "Fldche"

Das Blatt ,,Farbverlauf*
Abbildung 20 zeigt die Moglichkeiten, die dieses Blatt bietet.
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Qe Farbe Farbwerlauf: Bybd Myster Scheaftur

Farbwverlauf Optionen Vorschau

A Typ:
|Lir1ear |

Schrittweite:
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Abbildung 20: Farbverlauf

Im linken Teil kdnnen Sie unter vorgegebenen Verlaufen wahlen (die auch lhre eigenen,
hinzugefiigten enthalten kdnnen). Die vorhandenen Verlaufe bieten meist ein wenig
kontrastreiches Bild im Feld Vorschau auf der rechten Seite.

Im mittleren Teil kbnnen Sie nun die Details des Farbverlaufs bestimmen. Vergleichen Sie zu den
Parametern auch die Abbildung 27, bei der die gleichen Parameter am Beispiel der Transparenz
im Bild dargestellt werden.

Abbildung 21 zeigt die angebotenen Typen des Verlaufs am Beispiel eines Verlaufs von Weil3 zu
Dunkelgriin, bei einem Winkel von 0° (die Parameter werden gleich im Anschluss erlautert).

linear axial radial ellipsoid quadratisch rechteckig

Abbildung 21: Typen des Verlaufs

Abbildung 22 zeigt ein Beispiel, bei dem die Auswirkung der gesetzten Parameter deutlich zu
erkennen ist:
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Abbildung 22: Beispiel eines Farbverlaufs (grob und fein)
* Die Start- und Endfarben wurden mit Rot und Limette als deutliche Kontrastfarben gewéahlt.
e Als Typ wurde Rechteckig gewahlt.

* Bei der Schrittweite wurde Automatisch ausgeschaltet und links eine sehr grobe
Schrittweite von 10 gewahlt, um das Prinzip des Farblbergangs deutlich zu zeigen. Rechts
wurde eine Schrittweite von 50 gewahlt, damit die Ubergange flieRend erscheinen. Dies
kommt dem Standard Automatisch mit einer Schrittweite von 64 schon sehr nah.

* Beiden beiden Feldern Mitte wurde jeweils 50% gewabhlt, das heil3t, dass der Mittelpunkt
des Verlauf dem Mittelpunkt der Flache entspricht.

* Der Winkel betragt 141°, das heil3t, dass die Richtung (der langeren Kante) des fir den
Verlauf verwendeten Rechtecks anndhernd die Diagonale von links oben nach rechts unten
(135°) ist.

* Die Umrandung betragt wie beim Standard 0%, was bedeutet, dass bei der Farbung der
Flache der Bereich der mit der Startfarbe eingefarbt wird, nicht groRer ist als der Bereich
der anderen Abstufungen.

Erhéht man die Prozentzahl, dann wird der Bereich der Startfarbe eingefarbt, bei 100%
verschwindet der Verlauf vollstandig.

An einem einfachen Beispiel ist die Wirkung der Umrandung gut erkennbar, auch wenn es sich hier
nur um eine einseitige ,Umrandung® handelt (Abbildung 23):

Abbildung 23: Wirkung der Umrandung: links 0 %, rechts 40 %

Es wurde wieder die niedrige Schrittweite 10 gewahlt, damit die Abstufungen gut sichtbar sind; der
Winkel betragt 75°.

An diesem Beispiel kann auch gut das Prinzip der Fullung des Objekts gezeigt werden (Abbildung
24): Links wurde hinter die Ellipse ein Rechteck platziert, das die Ellipse gerade einhiillt und das
mit dem gleichen Verlauf gefillt wurde, nur wurde zusétzlich eine Transparenz von 30 % einge-
stellt, so dass dieser Hintergrund etwas blasser erscheint. Der Verlauf der Ellipse ist der
entsprechende Ausschnitt des Rechtecks, wodurch sich die schmaéleren Streifen am linken und
rechten Rand erklaren.
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Abbildung 24: Prinzip der Fillung mit einem Verlauf

Der rechte Teil der Abbildung zeigt, dass bei einem Rechteck, das den gleichen Neigungswinkel
hat, durch dieses Prinzip gerade die dreieckigen ersten und letzten Streifen am linken und rechten
Rand abgeschnitten werden, so dass der Verlauf hier nur aus 8 Streifen besteht. Bei einer
Ublicherweise deutlich hoheren Schrittweite fallt dieser Effekt nicht mehr auf.

Verwalten von Farbverlaufen

Wenn Sie eine neue Kombination der Parameter erstellt haben und diese fiir die spatere erneute
Verwendung aufheben wollen, kénnen Sie sie Uber Hinzufligen abspeichern. Eine bereits vor-
handene kénnen Sie tiber Andern geéandert speichern. Die Anderungen stehen dann auch anderen
Dokumenten Ihrer Installation zur Verfigung. Die Schrittweite wird dabei nicht gespeichert.

Léschen konnen Sie Farbverldufe tUber das Kontextmeni des Farbverlaufs.

Eine alternative Moglichkeit zur Beeinflussung einiger Parameter bieten die Menlupfade Form »
Umwandlungen » Farbverlauf-Werkzeug bzw. Kontextmenii » Umwandlungen »
Farbverlauf-Werkzeug. Sie konnen dort den Mittelpunkt verschieben und den Winkel des Verlaufs
bestimmen. AuBerdem Uber die Lange des Anfassers die GroRe der Umrandung bestimmen.

Das Blatt ,,Bild“
In diesem Blatt konnen Sie ein beliebiges Bild zum Fllen der Flache verwenden.

Einige Bilder werden zur Auswahl standardmalfiig angeboten, Sie kénnen ein anderes Bild
importieren Uber die Schaltflache Importieren. Sie miissen sich natirlich Uberlegen, ob das von
Ihnen gewahlte Bild zum Fillen der Flache geeignet ist. Umbenennen und léschen kdnnen Sie ein
solches Bild uber sein Kontextmenu.

Der vorgewahlte Stil ist gekachelt, das heil3t, dass das Bild so oft zum Fullen wiederholt wird, wie
es in waagrechter und senkrechter Position in die Flache passt bzw., dass es beschnitten wird,
wenn es in Originalgrofe zu grof fur die Flache ist. Sie konnen allerdings die Grof3e und
Anordnung der Kacheln in mehrerer Hinsicht beeinflussen (Abbildung 25):
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Abbildung 25: Kacheln einer Fldche
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Teil a) der Abbildung zeigt das Bild, das zum Fillen verwendet werden soll. Die Grol3e ist 3
X3 cm.

Teil b) zeigt die Fillung einer Flache ohne weitere Parameter: das Bild wird im Verhaltnis
zur Flache zentriert und in senkrechter Richtung beschnitten, in waagrechter Richtung
dagegen auf beiden Seiten wiederholt. In welcher Richtung beschnitten bzw. wiederholt
wird, hangt natirlich von der Gro3e der Flache ab.

Sie konnen die Grof3e einer Kachel bestimmen, indem Sie

o das Markierfeld Skalierung unmarkiert lassen und die Breite und Hohe der Kachel in
der eingestellten MalR3einheit (normalerweise cm) festlegen

o oder das Markierfeld Skalierung auswahlen und die Grof3e einer Kachel als Prozentsatz
der Breite bzw. Hohe des das Objekt umgebenden Rechtecks bestimmen.

In beiden Fallen wird das Bild ggf. in beiden Richtungen gedehnt oder gestaucht, damit es
die gewilinschte H6he und Breite hat, und dann so oft wie nétig in den jeweiligen Richtun-
gen wiederholt.

Teil c) zeigt eine Fullung, bei der in beiden Richtungen die Kachelgréf3e auf 0,5 cm
eingestellt wurde. Ein zweiter Parameter wurde geandert, der im folgenden Punkt
beschrieben wird.

Uber die beiden Parameter Kachelposition knnen Sie den Versatz der Kachelung
festlegen: Sie verschieben damit die Position des Punkts, an dem der Mittelpunkt der
zentralen Kachel ausgerichtet ist. Bei den einfachen Verhaltnissen des Beispiels passen
die Kacheln gerade sechsmal in waagrechter und dreimal in senkrechter Richtung in die
Flache, wobei dann die Randkacheln in beiden Richtungen gerade in der Halfte
abgeschnitten sind.

In Teil c) wurde nun ein Versatz in waagrechter Richtung von 50 % gewahlt, was bedeutet,
dass gerade dieses Abschneiden in der Mitte ausgeglichen wird, das Muster beginnt links
mit dem kraftig roten Kreis.

Teil d) schliel3lich zeigt die Anwendung des Parameters Kachelversatz. Dieser legt den
Versatz der Kacheln untereinander fest, im Gegensatz zum vorher beschriebenen Versatz
des die ganze Anordnung beeinflussenden Mittelpunkt der zentralen Kachel in Bezug zum
Flachenmittelpunkt.

Im Beispiel wurde ein Versatz von 40 % in der Zeile gewahlt (man kann entweder in der
Zeile oder in der Spalte versetzen), jede zweite Zeile der Kacheln ist somit um 40 %
gegenulber der mittigen Kernzeile nach rechts verschoben, am besten erkennbar an den
kréaftig roten Kreisen.

Sie konnen auRerdem die Stile Gestreckt und Benutzerdefinierte Position/Grél3e wahlen.

Der Stil Benutzerdefinierte Position/Grél3e streckt oder staucht das Bild in waagrechter und/oder
senkrechter Richtung auf die angegebene GréRe. Wenn das so erzeugte Bild groRer als die
Flache ist, wird es abgeschnitten, ist es kleiner, so fillt es nur einen mehr oder minder grof3en Teil
der Flache aus. In Abbildung 26 ist die Hohe 4,15 cm, die Breite 4,33 cm, die neun Ellipsen sehen
daher noch fast wie Kreise aus.

Der Stil Gestreckt fullt die Flache mit dem Bild, indem es das Bild in X- und Y-Richtung soweit
streckt, dass es gerade das das Objekt umgebende Rechteck fiillt; angezeigt wird natirlich nur der
Teil innerhalb des Objekts. Sie sehen dies in Abbildung 26 links:

Nicht moglich ist eine Fillung der Art, wie sie in Abbildung 26 manuell simuliert wurde, was in
diesem einfach konstruierten Fall noch machbar ist. Eine solche Verzerrung eines Bildes ist in
Draw nicht vorgesehen, dazu werden spezialisierte Formate und Programme bengtigt.

26
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Gestreckt Benutzerdefinierte Nicht méglich
Position/GroRRe

Abbildung 26: Die Parameter "Gestreckt" und "Benutzerdefinierte Position/Grél3e”

Das Blatt ,,Muster”

Das Blatt bietet eine Auswahl von Mustern, die auf einem 8x8-Raster basieren. Die vorgegebenen
Muster sind alle schwarz-weil3. Sie kdnnen die Farbe fiir Vorder- und Hintergrund dieses Musters
selbst bestimmen, sie sehen das Ergebnis sofort in einem Vorschaufenster.

Sie kénnen auch selbst neue Muster andern oder hinzufiigen:
e Wabhlen Sie die Vordergrund- und Hintergrundfarbe

* indem 8 x 8 - Feld Mustereditor klicken Sie die Quadrate an, die die Vordergrundfarbe
erhalten sollen

* sollten von dem Muster her, von dem Sie ausgegangen sind, Quadrate eine Vordergrund-
farbe haben, die in Ihrem Muster Hintergrund bilden sollen, dann klicken Sie diese an, um
die Vordergrundfarbe zu eliminieren.

* Verwenden Sie dann die Schaltflache Andern, um das gewahlte Muster zu andern, oder
Hinzufiigen, um ein neues Muster zu speichern; Sie kbnnen beim Speichern auch einen
Namen vergeben. Es steht dann auch fur andere Dokumente in lhrem Rechner zur
Verfligung.

Sie kdnnen Muster auch umbenennen oder Idschen: das Kontextmeni bietet beim Klick auf die
Auswabhlliste Muster beide Optionen. Wenn Sie ein Muster geldscht haben, ist es innerhalb der
Dokumente, in denen es verwendet wurde, weiterhin aktiv, allerdings nicht als Muster, sondern als
konkrete Formatierung des Objekts. Sie konnen es allerdings, ausgehend von einem solchen
Objekt, wiederum als Muster speichern, wenn die Léschung ein Versehen war.

Die Anderungen stehen dann auch anderen Dokumenten lhrer Installation zur Verfiigung.

Das Blatt ,,Schraffur*
Ahnlich wie im vorigen Abschnitt wird hier eine Auswahl an Schraffuren angeboten, die in diesem
Falle auch Farben verwenden.

Sie kénnen eine vorhandene Schraffur &ndern oder eine neue definieren, indem Sie den Linienab-
stand, den Winkel und den Linientyp (einfach, gekreuzt, dreifach) andern und dann tiber Andern
oder Hinzuftigen speichern. Ansonsten gelten die im vorigen Abschnitt genannten Aussagen.

Die Anderungen stehen dann auch anderen Dokumenten Ihrer Installation zur Verfligung.

Registerkarte ,,.Schatten*
Schatten kénnen Flachen, Linien oder Texten zugewiesen werden.Den aktuellen Schattenstil weist
man einfach durch Anklicken des Symbols Schatten der Symbolleiste Linie und Fillung zu.

Der Schatten, den LibreOffice erzeugt,_.ist immer ein Schatten mit scharfer Begrenzung, ein wei-
cher Schatten mit einem allmahlichen Ubergang zwischen Schattenfarbe und Hintergrund, wie ihn
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die eingefuigten Abbildungen zeigen , die durch das verwendete Werkzeug fur Screenshots erstellt
wurden, kann durch Draw nicht erzeugt werden.

Eine davon unabhangige Definition des Schattens erreichen Sie Gber Format » Flache »
Schatten oder Kontextmenii » Flache » Schatten, wo Sie festlegen kénnen, ob iberhaupt ein
Schatten gezeichnet werden soll, und dann die Position relativ zum Objekt, der Abstand und die
Schattenfarbe definieren kbnnen. Zusatzlich kénnen Sie die Transparenz des Schattens festlegen.
Der Schatten ist dabei immer ein hart begrenzter Schatten, ein weicher Ubergang zwischen
Schatten und Hintergrund ist nicht moglich.

Registerkarte ,, Transparenz*

Sie kénnen die Flache eines Objekts mehr oder weniger durchscheinend gestalten, indem Sie die
Transparenz der Flache definieren.

Fliche Schatten Transparenz

Bereich des Transparenzmodus 45°
() Keine Transparenz :

O'_I'ransparenz: 50 9% 2 20%

) Verlauf

Zentrum X |30 % =

Zentrum¥: |30 % - ; e
— Startwert 100 % Endwert 0 %

Winkel: 45° =
Urnrandung: |20 % =
Startwert: | 100% I =
Endwert: 0% =

Abbildung 27: Transparenz — Optionen und Prinzip des Verlaufs

Abbildung 27 zeigt die Einstellmoglichkeiten und zusatzlich die Erlauterung der Parameter am
Beispiel eines linearen Verlaufs.

Sie kdnnen wahlen zwischen:
* keine Transparenz: die Standardeinstellung, die Flache ist solide mit der Farbe gefiillt

* Transparenz: mit einer Prozentangabe legen Sie fest, wie weit die darunter liegenden
Objekte durchschimmern: 0 % bedeutet keine Transparenz und entspricht dem vorigen
Fall, 100% bedeutet totale Transparenz und hat die gleiche Wirkung wie die Einstellung,
dass die Flache ohne Fullung ist (s. ,Das Blatt ,Ohne auf Seite 21); dazwischen liegende
Angaben lassen mit steigendem Wert das darunter liegende Objekt immer deutlicher
erscheinen.

* Verlauf: Hier kbnnen Sie anstatt einer gleichméaRigen Anwendung der Transparenz auf die
gesamte Flache die Transparenz lokal unterschiedlich einstellen, wobei Sie die Varianz des
Ergebnisses durch mehrere Parameter einstellen kénnen. Dies wird im folgenden Abschnitt
naher beschrieben.

Auch hier gilt wieder: Wenn Sie hier Einstellungen vornehmen, ohne dass ein Zeichnungsobjekt
selektiert ist, dann setzen Sie einen Standard, der fUr die zukiinftig neu erzeugten Objekte
angewendet wird.
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Einstellméglichkeiten beim Verlauf

Die Wirkung der in Abbildung 27 gezeigten Parameter bei der Wahl der Option Verlauf ist die
gleiche wie bei der Einstellung fir den Verlauf (s. ,Das Blatt ,Farbverlauf* auf Seite 22), mit dem
einzigen Unterschied, dass anstatt der Start- und Endfarbe hier ein Start- und End-Prozentwert fir
die Transparenz anzugeben ist, die die fur die Flache gewahlte Farbe opaker oder transparenter
erscheinen lassen.

Farbverlauf-Werkzeug

Sie haben auch die Méglichkeit, den Farbverlauf in mancher Hinsicht direkt am Objekt zu beein-
flussen. Das Zeichnungsobjekt muss dazu bereits einen Farbverlauf besitzen. Selektieren Sie es
und wahlen Sie dann einen der folgenden Wege:

Form » Umwandlungen » Farbverlauf-Werkzeug
Kontextmenii » Umwandlungen » Farbverlauf-Werkzeug

Klappen Sie das Symbol Umwandlungen der Symbolleiste Linie und Fiillung auf und
wahlen Sie Interaktives Farbverlauf-Werkzeug; wenn das zugehoérige Symbol bereits im
Symbol Umwandlungen angezeigt wird, kdnnen Sie es auch direkt anklicken.

Aktivieren Sie die Symbolleiste Umwandlungen und und wéhlen Sie das Symbol
Interaktives Farbverlauf-Werkzeug.

Es erscheint (Abbildung 28) eine gestrichelte Linie, die zwei gefarbte Quadrate verbindet. Der Pfeil
— der auf der Abbildung nur schwer zu erkennen ist, weil seine Grof3e mit der Lange der Linie kor-
reliert ist — zeigt auf das Quadrat mit der Endfarbe, das andere Quadrat zeigt die Anfangsfarbe.

&= |

|

Abbildung 28: Interaktives Farbverlauf-Werkzeug

Was Sie mit diesem Werkzeug verandern kénnen, hangt vom Typ des Verlaufs ab:

linearer Verlauf. Bewegen Sie das Endquadrat des Pfeils, um den Winkel des Verlaufs zu
andern, und das Startquadrat, um die Groé3e der Umrandung zu beeinflussen.

axialer Verlauf. nur das Zielquadrat ist beweglich: die Lange der Linie bestimmt die GroRRe
der Umrandung, die Richtung den Winkel.

radialer Verlauf. die Lage des Zielquadrats legt das Zentrum des Verlaufs fest, die Lange
der Linie bestimmt den Radius des Verlaufs und damit die Gréf3e der Umrandung

ellipsoider, quadratischer und rechteckiger Verlauf. bewegen Sie das Startquadrat, um
durch die Lange der Linie die GroRe der Umrandung und durch seine relative Lage zum
Zielguadrat den Winkel festzulegen, und das Zielquadrat, um das Zentrum des Verlaufs zu
bestimmen.

Formatieren von Flachen 29



Interaktives Transparenz-Werkzeug

Ahnlich wie das gerade geschilderte Farbverlauf-Werkzeug gibt es auch eines fur die Transparenz.
Es besteht auch aus zwei Geraden und einem Pfeil zwischen den beiden, wobei die Quadrate
nicht die Start- und Endfarbe anzeigen, sondern weifld und schwarz als Symbol fir volle bzw. keine
Transparenz verwenden. Das heil3t, dass es genaugenommen ein Werkzeug fir den speziellen
Fall eines Transparenzverlaufs darstellt. Den Wert fiir die Transparenz an sich, der sicher haufiger
bendtigt wird, kann man damit nicht einstellen.

Der Aufruf ist analog zu dem fir das Farbverlauf-Werkzeug (s. ,Farbverlauf-Werkzeug" auf Seite
29). Das Werkzeug ist allerdings derzeit leider nicht fiir die meisten Standardformen verfugbar, die
Uber die Symbolleiste Zeichnung angeboten werden, sondern nur fir Formen, die direkt als
geschlossene Kurven oder Polygone gezeichnet wurden, oder fir Textfelder. Voraussetzung ist
ahnlich wie beim Farbverlauf, dass bereits ein von 0 abweichender Start- oder Endwert
eingegeben wurde.

Der Fehler, dass das Werkzeug fir die Standardformen nicht verfligbar ist, ist seit Langerem
gemeldet (https://bugs.documentfoundation.org/show_bug.cgi?id=89565).

Formatvorlagen

. . Lesen Sie als Ergéanzung eventuell das Kapitel 3 — Einflihrung in Formate und
Hinweis Vorlagen des Handbuchs Erste Schritte.

Formatvorlagen biindeln Formatierungen in einer eigenen Einheit, die Sie dann immer wieder
nutzen kénnen, um all diese Eigenschaften mit einer einfachen Zuweisung auf ein Objekt zu
Ubertragen. So kénnen Sie Arbeit beim Formatieren einsparen und leicht ein gleichméaRiges
Erscheinungsbild erreichen.

Der Einsatz von Formatvorlagen liegt in Draw vielleicht nicht so auf der Hand wie in Writer, wo ein
Dokument leicht Hunderte von Abséatzen haben kann, von denen viele dann gleichartig formatiert
sein sollten; da ist es selbstverstandlich, dass man da die Standardvorlage entsprechend anpasst
oder eine eigene Vorlage einsetzt.

In Draw kann man sich oft sehr gut ohne Formatvorlagen behelfen, indem man Zeichnungsobjekte
mit ihren Formatierungen kopiert und dann das Objekt verandert, oder indem man das Format
Uber den ,Pinsel* nachtraglich andert.

Wirklich schlagkréftig wird das Konzept allerdings in Verbindung mit einer Dokumentvorlage: diese
enthalt dann eine Reihe von Formatvorlagen und wird als Ausgangsbasis zum Erstellen neuer
Dokumente verwendet, die dann sogleich alle dort enthaltenen Formatvorlagen erben, die Sie
somit sofort verwenden konnen.

Formatvorlagen enthalten, da sie alle von universellen, mit LibreOffice ausgelie-
Hinweis ferten Vorlagen abstammen, auch Attribute, die fur die Objekte, fir die sie gedacht
ist, gar nicht zutreffen. Solche Attribute werden ggf. einfach ignoriert.

Formatierung mittels einer Formatvorlage

LibreOffice enthalt fir Draw bereits eine kleine Auswahl von Formatvorlagen fir Zeichnungsobjek-
te. Zur Ihrer Anzeige wird inzwischen offenbar nur noch die Seitenleiste genutzt. Wenn diese gar
nicht oder die entsprechende Seite nicht angezeigt wird, kdnnen Sie sie anzeigen auf folgenden
Wegen:

* Ansicht » Formatvorlagen

* Format » Vorlagen » Formatvorlagen verwalten
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* Ansicht » Seitenleiste und dort dann in der rechten Spalte das Symbol fir
Formatvorlagen auswahlen

Selektieren Sie ein Zeichnungsobjekt und doppelklicken Sie dann auf die gewiinschte
Formatvorlage. Die Vorlage wird dann dem Objekt zugewiesen.

Abbildung 29 zeigt die im Standard in LibreOffice vorhandenen Vorlagen in der hierarchischen Dar-
stellung, auf die wir spater noch zurickkommen; nicht alle Vorlagen werden im Beispiel dargestellt,
erkennbar an den +-Zeichen vor manchen Eintragen.

Die Art der Darstellung setzen Sie Uber die Auswabhlliste am Ful3 Blattes, die als weitere Moglich-
keiten bietet: Alle, verborgene, verwendete oder Benutzervorlagen.
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Standard

Text i

Yorschauen anzeigen

Hierarchisch w

Abbildung 29: Formatvorlagen

Die Hierarchie von Formatvorlagen

Formatvorlagen sind — nicht nur in Draw — hierarchisch organisiert: eine Vorlage basiert immer auf
einer anderen, von der sie gewisse Formatierungen erbt, wenn sie sie nicht Gberschreibt. Libre-
Office liefert eine Hierarchie aus, die Sie durch eigene Vorlagen ergdnzen kdnnen; allerdings
kénnen Sie die von LibreOffice gelieferten Vorlagen nicht l6schen, sondern nur die selbst
erzeugten. Die Hierarchie sehen Sie teilweise in Abbildung 29.
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Der Vorteil der Hierarchie ist, dass Sie allgemeingultige Eigenschaften auf einer hdheren Ebene,
speziellere auf einer niedrigeren ablegen kénnen, so dass jeweils nur an einer Stelle gedndert wer-
den muss, wenn der Bedarf besteht. Ein einfaches Beispiel: Sie méchten gern, dass alle Texte in
Ihrer Zeichnung die gleiche Schriftart und -gréf3e verwenden, also erzeugen Sie zunachst eine Vor-
lage auf der Basis der Vorlage Standard, bei der Sie die gewlinschten Anderungen eingeben. Da
die Vorlage auch fur Textfelder gelten soll, die Ublicherweise weder Flachenfarbe noch Umrandung
haben, setzen Sie diese beiden Eigenschaften auf ,ohne®. Dann mochten Sie fur Flachen drei Far-
ben verwenden, also richten Sie unter der gerade definierten Vorlage drei weitere ein, bei der Sie
die Flachenfarbe und ggf. Umrandung entsprechend setzen, und, wenn es eine dunkle Farbe ist,
wahlen Sie vielleicht auch noch eine helle Schriftfarbe.

Definieren einer Formatvorlage

Sie kénnen eine bestehende Formatvorlage andern, wenn Sie sie in der Seitenleiste auswahlen
und den Befehl Andern aus dem Kontextmeni wahlen.

Das Andern einer von LibreOffice gelieferten Vorlagen hat jedoch den eventuellen Nachteil, dass
ein Zeichnungsobjekt, das Sie aus einem anderen Dokument kopieren, in Threm Dokument plotz-
lich anders aussieht. Existiert namlich die Formatvorlage, die dem kopierten Objekt im Quelldoku-
ment zugewiesen wurde, auch im Zieldokument, dann wird sie dem kopierten Dokument wiederum
zugewiesen, auch wenn sie vielleicht ganz andere Eigenschaften hat. Es wird daher meist sinnvoll
sein, einen neue Vorlage mit einem geniigend speziellen Namen zu erstellen, um solche
Uberschneidungen zu vermeiden.

Einen neue Vorlage erstellen Sie, indem Sie in der Seitenleiste die Vorlage anklicken, der die neue
hierarchisch untergeordnet sein soll, dann einen neuen Namen vergeben, die gewlinschten Eigen-
schaften setzen und mit OK bestatigen. Die neue Vorlage ist im Dokument gespeichert.

Erstellen oder Andern einer Formatvorlage aus einem ausgewéhlten Objekt

1. Wabhlen Sie das Zeichnungsobjekt aus, das die Grundlage fir die neue Formatvorlage
bildet.

2. Wabhlen Sie die Formatvorlage aus, auf der die neue Formatvorlage basieren soll, der sie
also in der Hierarchie untergeordnet werden soll.

3. Wabhlen Sie das Symbol Neue Vorlage aus Auswahl (das Pluszeichen in Abbildung 29 im
oberen Teil).

4. Im folgenden Dialog Vorlage erstellen konnen Sie der neuen Formatvorlage einen Namen
geben; speichern Sie sie dann mit OK.

Die Alternative Uber den Menupfad Format » Vorlagen » Neue Formatvorlage aus Auswabhl in
Schritt 3 funktioniert leider nicht
(als Bug gemeldet: https.//bugs.documentfoundation.org/show_bug.cgi?id=128787).

Dieser Dialog zeigt auch die bereits vorhandenen Anwendervorlagen an, und Sie
kénnen auch eine bestehende auswéhlen. Sie werden dann noch einmal gefragt, ob
Sie die Formatvorlage Uberschreiben wollen. Wenn Sie das bejahen, wird sie
tatséchlich geédndert.

Vorsicht Das hat jedoch den Nachteil, dass bereits vorhandene Zeichnungsobjekte, die diese
Formatvorlage verwendeten, die Beziehung zu ihr verlieren und mit der hierarchisch

A dartiber liegenden verbunden werden. Man kann dieses Vorgehen allerdings gut

verwenden, wenn man sich noch im Entwurf der Formatvorlage befindet und am
Testobjekt fiir diese Vorlage Anderungen durch direkte Formatierung ausprobiert
hat, die nun in die Vorlage ibernommen werden sollen.
Besser ist jedoch das in ,Andern auf Basis eines Objekts* auf Seite 33 beschrieben
Verfahren.
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Sie kdnnen die Zuordnung zur tUbergeordneten Vorlage auch andern, indem Sie im Reiter
Verwalten beim Feld basierend auf die gewiinschte Vorlage auswéhlen oder in der hierarchischen
Darstellung (s. ,Die Hierarchie von Formatvorlagen” auf Seite 31) die ausgewahlte Formatvorlage
mit gedrickter Maustaste unter die Vorlage verschieben, der sie untergeordnet sein soll; wenn Sie
einen waagrechten Strich an der richtigen Stelle sehen, lassen Sie die Maustaste los.

Andern einer Formatvorlage
Sie haben die folgenden Mdglichkeiten:

e Wabhlen Sie in der Seitenleiste in der Liste der Formatvorlagen die gewtlinschte Vorlage und
Kontextmenii » Andern...

« Offnen Sie bei einem Objekt, das diese Formatvorlage verwendet, durch Rechtsklick das
Kontextmenii und wéahlen Sie Vorlage bearbeiten...

* Selektieren Sie ein Objekt, das diese Formatvorlage verwendet, und wahlen Sie Format »
Vorlagen » Vorlage bearbeiten...

Nehmen Sie dann im Dialog Zeichnungsvorlagen die gewlnschten Anderungen vor und bestatigen
Sie die Anderung mit OK.

Andern auf Basis eines Objekts

Wenn Sie bei einem Zeichnungsobjekt, das auf einer Formatvorlage beruht, eine Anderung
vorgenommen haben, die Sie gerne in die Formatvorlage Ubernehmen mochten, dann selektieren
Sie das Objekt und wahlen dann die Schaltflache Vorlage aktualisieren, die Sie in Abbildung 29
direkt unter dem Kreuzsymbol flr Seitenleiste schlie3en sehen. Alternativ kdnnen Sie das Objekt
selektieren und dann Format » Vorlagen » Ausgewdhlte Formatvorlage aktualisieren wahlen.

Selbst wenn Sie versehentlich nach dem Selektieren des Objekts eine andere Formatvorlage in
der Seitenleiste ausgewahlt haben sollten, wird die korrekte Formatvorlage aktualisiert.

Ldschen einer Formatvorlage

Hi . Sie kénnen nur benutzerdefinierte Formatvorlagen l6schen, bei anderen erscheint
(= der Menupunkt nicht.

Wabhlen Sie die zu l6schende Formatvorlage in der Seitenleiste aus
Waéhlen Sie Kontextmenii » Léschen

Wenn die Formatvorlage noch fir Zeichnungsobjekte verwendet wird, erscheint ein
Warndialog mit entsprechender Information, so dass Sie das Ldschen noch abbrechen
konnen.

4. Wenn Sie das Ldschen bestatigt haben oder gar keine Warnung kam, wird die
Formatvorlage geldscht.

Der Warnhinweis enthélt derzeit einen falschen Text: Es wird gesagt, dass dann die Vorlage
Standard zugewiesen wirde. Das ist ein Fehler in der deutschen Fassung, richtig ist, dass die der
zu léschenden tUbergeordnete Formatvorlage zugewiesen wird. AulRerdem steht dort das Wort
L1ext’ (auch in der englischen Fassung), wo ,Formatierung” korrekt ware.

Wenn Sie sehen wollen, welche Formatvorlagen verwendet werden, wahlen Sie Verwendete
Vorlagen in der Auswabhlliste am Ful3 der Seitenleiste (s. Abbildung 29).
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Verwendung von Dokumentvorlagen

Wenn Sie die gleichen Formatierungen immer wieder in neuen Dokumenten verwenden wollen,
empfiehlt sich oft die Erstellung einer Dokumentvorlage. Erstellen Sie dazu in einem Dokument die
erforderlichen Formatvorlagen; das Dokument kann daneben auch andere Inhalte wie Textfelder
Bilder usw. enthalten, die in den neu zu erzeugenden Dokumenten auch immer vorhanden sein
sollen.

Speichern Sie dann das Dokument tber Datei » Dokumentvorlagen » Als Dokumentvorlage
speichern.

Das Dokument erhalt die Endung .odt. Wenn Sie dieses Dokument 6ffnen, wird automatisch eine
Kopie als neues Dokument erzeugt (das dann wieder ein normales Zeichnungsdokument mit der
Endung .odt ist), das alle Inhalte und insbesondere alle Formatvorlagen schon enthalit.

N&heres finden Sie in Kapitel 3 — Einfihrung in Formate und Vorlagen des Handbuchs Erste
Schritte.

Weitere Veranderungen eines Objekts

Draw bietet noch weitere Werkzeuge, die Form eines Zeichnungsobjekts (im weiteren Sinn) zu
andern. Diese sind unter dem Begriff Umwandlungen zusammengefasst (Abbildung 30); verglei-
chen Sie aber auch ,Umwandeln“ auf Seite 40. Sie kdnnen diese Funktionen aufrufen tber:

* das Symbol Umwandlungen in der Symbolleiste Linie und Fllung

* die Symbolleiste Umwandlungen, die Sie dann gegebenenfalls tber Ansicht »
Symbolleisten » Umwandlungen einblenden miussen

* den Menupfad Form » Umwandlungen

B Drehen E‘EI Setzen auf Kreis (schrag stellen)
1

ﬂ[l Spiegeln I_. Verzerren

‘t In 30-Rotationskarper . Transparenz-Werkzeug

E‘E‘? Setzen auf Kreis (perspektivisch) . Farbverlauf-Werlzeug

Abbildung 30: Umwandlungen
Manche dieser Umwandlungen sind schon an passender Stelle besprochen worden:
* Drehen im Kapitel 3 dieses Handbuchs

* Transparenz- und Farbverlauf-Werkzeug in diesem Kapitel (s. ,Interaktives Transparenz-
Werkzeug" auf Seite 30 bzw. ,Farbverlauf-Werkzeug" auf Seite 29).

Die restlichen Werkzeuge werden im Folgenden beschrieben.

Spiegeln

Das Werkzeug Spiegeln aus der Symbolleiste Umwandlungen erméglicht die Spiegelung an jeder
gewunschten Achse. Fir die Standardfalle der waagrechten und senkrechten Spiegelung gibt es
eine direktere Alternative.

Direktes Spiegeln

Wenn Sie ein Objekt an seiner waagrechten oder senkrechten Mittellinie spiegeln wollen, kbnnen
Sie das schneller auf einem der folgenden Wege erreichen:
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den Menlpfad Kontextmenii » Spiegeln
den Menupfad Form » Spiegeln
Seitenleiste » Position und Grolie

die Symbolleiste Linie und Fiillung

In allen Fallen werden dann die Moglichkeiten Horizontal und Vertikal angeboten.

Spiegeln an einer beliebigen Achse

Wenn die Spiegelachse nicht einen der beiden genannten Mittelachsen sein soll, gehen Sie
folgendermalRlen vor:

1.
2.
3.

Selektieren Sie das Objekt.
Waéhlen Sie das Werkzeug Spiegeln aus der Symbolleiste Umwandlungen.

Es erscheint eine gestrichelte Linie mit Anfassern an beiden Enden (Abbildung 31, Bild a),
die die Spiegelachse symbolisiert.

Sie kénnen nun diese Achse verschieben (Abbildung 31, Bild b):

o indem Sie die beiden Anfasser mit der Maus verschieben: so kénnen Sie sowohl den
Winkel als auch die der Spiegelachse im Verhaltnis zum Objekt verandern.

o indem Sie die Spiegellinie zwischen den beiden Endpunkten mit der Maus verschieben:
hier bleibt der Winkel erhalten.

o Indem Sie das Objekt mit der Maus oder den Pfeiltasten verschieben: auch hier bleibt
der Winkel erhalten.

o Indem Sie Strg+Tab dricken, dann ist die Linie selektiert, ein weiteres Mal Strg+Tab
drucken, dann ist der erste Anfasser markiert, noch ein weiteres Mal Strg+Tab markiert
den zweiten Anfasser. Sie kdnnen das so markierte jeweilige Element mit den Pfeil-
tasten verschieben.

Selbstverstandlich kdnnen Sie wie sonst auch mit Umschalt+Strg+Tab die Elemente in
der umgekehrten Richtung durchlaufen.

Klicken Sie nun einen der acht Bearbeitungsgriffe des Objekts an; der Mauszeiger andert
sein Symbol. Bewegen Sie bei gedriickter Maustaste den Zeiger Uber die Spiegelachse
hinweg, bis ein Phantombild des gespiegelten Objekts erscheint (Abbildung 31, Bild c).

Lassen Sie die Maustaste los, das Objekt ist dann gespiegelt.
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Abbildung 31: Spiegeln an einer Achse

Wenn Sie beim Verschieben der Endpunkt der Spiegellinie die Umschalt-Taste gedriickt halten,
wird der Winkel auf Vielfache von 45° beschréankt.

Die Lange der Spiegellinie hat keine Auswirkungen, ebenso wenig ihre Lage auf der durch sie der
Lange nach hindurch gehenden Geraden.

In einen 3D-Rotationskdrper umwandeln
Abbildung 32 zeigt ein Beispiel fur die Anwendung dieses Werkzeugs.

1. Selektieren Sie das Objekt (in diesem Fall die Form Puzzle aus den Symbolformen, links im
Bild). Sie kdnnen auch mehrere Objekte auswahlen.

2. Wabhlen Sie die Symbolleiste Umwandlungen auf einem der in ,Weitere Veréanderungen
eines Objekts" auf Seite 34 beschriebenen Wege.

3. Wahlen Sie das Symbol In 3D-Rotationskérper.

Es erscheint ein gespiegeltes Phantombild des Objekts mit der Spiegelachse dazwischen.
Diese Achse kdnnen Sie wie beim Spiegeln verschieben.

5. Kilicken Sie irgendwo; nach kurzer Wartezeit erscheint das erzeugte 3D-Objekt, wie im
dritten Teil der Abbildung zu sehen.

6. Um den Rotationskorper ganz rechts zu erzeugen, wurde der untere Anfasser der Spiegel-
linie leicht nach rechts verschoben, so dass sich die Puzzleteile in der Mitte leicht Gber-
schnitten. Schon leichte Anderungen der Achse kdnnen deutlich andere Korper erzeugen!

Abbildung 32: Umwandlung in einen 3D-Rotationskérper
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Drehen des Rotationskérpers

Wie andere Zeichnungsobjekte auch (s. Kapitel 3 — Objekte und Objektpunkte dieses Handbuchs)
konnen Sie den Rotationskorper auch drehen. Klicken sie dazu zweimal (kein Doppelklick!) auf
den Rotationskdrper, damit die Drehpunkte erscheinen. Sie kénnen nun den Kdrper drehen, indem
Sie einen der acht Eck- oder Seitenmittelpunkte anklicken und mit gedrtickter Maustaste die Maus
verschieben. Der Mauszeiger verandert sich dabei in ein Drehsymbol. Abbildung 33 zeigt das Er-
gebnis fur den in Abbildung 32 im vorletzten Bild gezeigten Kérper, nachdem der Mauszeiger vom
Drehpunkt rechts oben in etwa in die Position verschoben wurde, die das Drehsymbol anzeigt.

Cr

Abbildung 33: gedrehter Rotationskérper
Die Drehpunkte haben unterschiedliche Wirkungen:

* Die Eckpunkte bewirken offenbar das Gleiche, namlich eine Drehung des Objekts um die
Achse, die senkrecht zur Bildschirmoberflache steht.

* Die senkrechten Seitenmittelpunkte links und rechts kippen den Kérper um die waagrechte
Achse der Bildschirmoberflache.

* Die waagrechten Seitenmittelpunkte oben und unten drehen den Korper um die senkrechte
Achse der Bildschirmoberflache.

Der zentrale Punkt, in Abbildung 33 mit einer Art Fadenkreuz gekennzeichnet, ist das Zentrum der
Drehung. Sie kénnen ihn verschieben, was dann bei der Arbeit mit den Drehpunkten ganz andere
Ergebnisse liefert.

Auch hier kbnnen Sie mit Strg+Tab bzw. Umschalt+Strg+Tab die Drehpunkte auswahlen und mit
den Pfeiltasten bewegen.

Setzen auf Kreis (perspektivisch)

Dieses Werkzeug verzerrt das Objekt, indem es es auf einen Kreisabschnitt projiziert. Der Winkel
des Kreisabschnitts bedingt die Dehnung und Verformung des Objekts. Fassen Sie dazu einen
der Anfasser des Objekts an und bewegen Sie die Maus. Die Wirkung h&ngt durchaus vom An-
fasspunkt ab. Abbildung 34 zeigt oben jeweils das Ausgangsobjekt und unten links die Wirkung
beim Ausflihren des Befehls, erkennbar am Phantombild, bei einem Kreisabschnitt von fast 90°,
wobei der rechte obere Anfasser ausgewahlt wurde; rechts das Ergebnis nach dem Loslassen der
Maustaste.

Das Verhalten dieser Funktion kann durch die Option Extras » Optionen... » LibreOffice Draw
» Allgemein » Objekte in Kurven nicht verzerren beeinflusst werden. Abbildung 34 wurde mit
deaktivierter Option (der Standardeinstellung) erzeugt, aus den Quadraten wurden Kreissegmente;
Abbildung 35 wurde mit aktivierter Option erstellt, die Quadrate behalten ihre Form bei.
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Abbildung 34: Setzen auf Kreis (perspektivisch) mit Option "... nicht verzerren" inaktiv

EEEEE EEEEE
rEEERR 0 [y ®

'''''
A, = = e
----

Wi

Abbildung 35: Setzen auf Kreis (perspektivisch) mit Option "... nicht verzerren" aktiviert

Dabei muss das Objekt gegebenenfalls erst in eine Kurve umgewandelt werden, was zuvor per
Dialog abgefragt wird.

Setzen auf Kreis (schrag stellen)

Im Gegensatz zum vorigen Werkzeug ist die Flache, auf die das Objekt abgebildet wird, nicht ein
zweidimensionaler Kreisabschnitt, sondern die zweidimensionale Abbildung eines gebogenen
Bands, das sich von der Bildschirmoberflache in Richtung des Anwenders biegt (Abbildung 36).
Auch hier hangt das Ergebnis stark von der Wahl des Anfassers ab, im Beispiel wurde wieder einer
der obere rechte Anfasser verwendet. Die Option Objekte in Kurven nicht verzerren war inaktiv.

Abbildung 37 zeigt das Ergebnis bei aktivierter Option.
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Abbildung 36: Setzen auf Kreis (schrég stellen) mit Option "... nicht verzerren" inaktiv
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Abbildung 37: Setzen auf Kreis (schrég stellen) mit Option "... nicht verzerren" aktiviert

Verzerren
Dieses Werkzeug verzerrt ein gegebenes Objekt nach unterschiedlichen Prinzipien.
Das linke Bild in Abbildung 38 zeigt das Ausgangsobjekt.

Das mittlere Bild zeigt den Zustand bei der Bearbeitung, wenn ein Eckpunkt verschoben wurde:
das Objekt wird auf ein rechteckiges Raster projiziert, dessen einer Eckpunkt dann verschoben
wird, was ein allgemeines Viereck produziert, entsprechend wird das Objekt verzerrt. Das Ergeb-
nis, aus technischen Grinden nicht hundertprozentig identisch, zeigt das rechte Bild.

Wird dagegen ein Seitenmittelpunkt verschoben (Abbildung 39), so bedeutet dies einfach eine
Scherung in Kombination mit einer GréRenédnderung: das linke Bild zeigt die Scherung in
waagrechter Richtung, die gestrichelte Linie ist eine Fanglinie (s. Kapitel 3 — Arbeiten mit Objekten
und Objektpunkten dieses Handbuchs), die das exakte Verschieben in dieser Richtung erleichtert;
das mittlere die GréRenanderung in vertikaler Richtung, das rechte die Kombination beider.
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Abbildung 39: Verzerren vom Seitenmittelpunkt aus

Umwandeln

Dieser Meniipunkt lasst sich im Deutschen leider sehr leicht mit Umwandlungen verwechseln (s.
Weitere Veranderungen eines Objekts” auf Seite 34), im Englischen heil3t der hier besprochene
Convert, der weiter oben behandelte dagegen Transformations.

Die hier zusammengefassten Funktionen lassen sich nur Gber Form » Umwandeln oder
Kontextmenii » Umwandeln aufrufen. Es bietet sich die folgende Auswahl:

_Ea In Kurve

ﬁ In Polygon
In Kontur
A In3D

ﬂl In 30-Rotationskarper
In Bitrnap
In MetaFile

Abbildung 40: Umwandeln
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Umwandeln in Kurven oder Polygone

Die ersten drei Menlipunkte werden am Besten zusammen behandelt, da sie Gemeinsamkeiten
haben und sich teilweise tberschneiden. Hier wird die Anwendung dieser Funktionen auf
Zeichnungsobjekte beschrieben, die Anwendung auf Bilder, die teilweise andere Ergebnisse liefert,
finden Sie in Kapitel 6 — Bilder bearbeiten dieses Handbuchs.

Art der Umwandlung

Alle drei genannten Funktionen wandeln ein Zeichnungsobjekt in eine Menge von Polygonen oder
von Bézierkurven um, wobei der Begriff Bézierkurve von LibreOffice auch schon im Sinn einer
Kombination mehrerer elementarer Bézierkurven verstanden wird, die aneinander anschlie3en.
Eine Ellipse z. B. wird in diesem Sinn noch als eine Bézierkurve aufgefasst, nur wenn die Selektion
mehrere Ellipsen umfasst, die sich nicht Gberschneiden, enthalt die Ergebnismenge mehrere
Elemente, wenn sie sich Uberschneiden, ist die Bézierkurve entsprechend kompliziert.

Abbildung 41 zeigt das Ergebnis einer Umwandlung einer Ellipse.

Abbildung 41: Umwandlung in Polygon (links) und Bézier (rechts)

e die Umwandlung in ein Polygon erzeugt einen Streckenzug, eine Aneinanderreihung von
geraden Strecken, die aneinander anschlieen und fir das Auge bzw. die Auflésung des
Bildschirms oder Drucks eine ausreichende Annéherung an die Ideallinie darstellen. Intern
werden hier die einzelnen bendétigten geraden Strecken zwischen den durch die vielen
Quadrate erkennbaren Punkten als Kombination von Anfangs- und Endpunkt gespeichert.

* die Umwandlung in eine Kurve erzeugt eine Folge von Bézierkurven, die aneinander an-
schliel3en. Die Anzahl der daftir benétigten Punkte auf der sichtbaren Darstellung ist daher
deutlich geringer, allerdings werden fir jede Kurve weitere Parameter bendtigt, die die
Steuerpunkte der Bézierkurve beschreiben (s. Kapitel 11 — Weiterfihrende Themen).

* die Umwandlung in eine Kontur scheint im Wesentlichen abhangig von der Art der Aus-
gangsgrafik entweder ein Polygon oder eine Bézierkurve zu sein. Allerdings bestehen im
Detail in den Daten des Objekts kleine Unterschiede zwischen einem in Kontur umgewan-
delten und einem in ein Polygon bzw. in eine Kurve umgewandelten Objekt, die sich aller-
dings optisch nicht zeigen.

Bearbeitung des umgewandelten Objekts

Das Ergebnis der Umwandlung ist entweder (im allgemeinsten Fall) ein Menge von Polygonen
oder von Bézierkurven. Diese kdnnen Sie nun bearbeiten.

Dazu mussen Sie die Punktbearbeitung aktivieren. Daflr gibt es die folgenden Wege:
* den Menupfad Bearbeiten » Punkte
* Kontextmenii » Punkte
* die Taste F8

* das Symbol Punkte oder Punkte bearbeiten in der Standardsymbolleiste oder den
Symbolleisten der diversen Benutzeroberflachen.
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Damit ist zunachst nur die Punktbearbeitung aktiviert, was Sie im Normalfall daran sehen kénnen,
dass anstatt der Begrenzungspunkte des umgebenden Rechtecks die Eckpunkte der Form

markiert sind (Abbildung 42).
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Abbildung 42: Punktebearbeitung, links inaktiv, rechts aktiv

Damit Sie die Punkte aber tatséchlich bearbeiten kénnen, miussen Sie ggf. die Symbolleiste
Punkte bearbeiten aktivieren (Uber Ansicht » Symbolleisten), s. Abbildung 43. Nur bei der
Benutzeroberflache In Registern sind diese Symbole schon direkt im Symbolband sichtbar.

Punkte bearbeiten
Al A [ ¥

Abbildung 43: Symbolleiste ,,Punkte bearbeiten”

Abbildung 44 zeigt die Bedeutung der einzelnen Symbole.

Punkte verschieben (’H In Kurve umwandeln I__: Eckpunkt setzen
Punkte einfligen n_] Bezier schliefien Fcﬁl Glatter Ubergang 'S Punkte reduzieren
. " G0g =
y .,  Punkte laschen b Kurve auftrennen (ﬁ‘l Symmetrischer Ubergang

Abbildung 44: Bedeutung der Symbole
Hier werden nur die Symbole besprochen, die nicht nur bei Bézierkurven aktivierbar sind, weil die
Behandlung der Bézierkurven im Gesamtzusammenhang in Kapitel 11 — Weiterflihrende Themen

erfolgt.

Punkte verschieben
Wenn dieses Symbol aktiv ist, kbnnen Sie einen Griff des Objekts anklicken und ihn verschieben

Die Wirkung héngt nun vom Typ des Objekts ab:
ist es ein Polygon, so werden die Verbindungslinien zwischen dem Punkt und seinen
Nachbarpunkten links und rechts einfach als Gerade verandert.

Ist es eine Bézierkurve, dann werden auch Bézierkurven von diesem Punkt zu den beiden
Nachbarpunkten erzeugt, die Sie dann anschliel3end durch weitere Bearbeitung (s. Kapitel

11 — Weiterfiihrende Themen) verandern kbnnen.
Abbildung 45 zeigt das Verschieben anhand eines gefiiliten Polygons, das ein Rechteck darstellt.
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Abbildung 45: Punkt verschieben
Stellen Sie sicher, dass das Symbol Punkte verschieben aktiv ist.

2. Zeigen Sie mit der Maus auf den Punkt den Sie verschieben méchten; das Bild des Maus-
zeigers wird durch ein kleines Quadrat erganzt.

3. Bewegen Sie bei gedriickter Maustaste den Mauszeiger an die gewlinschte Stelle.
4. Lassen Sie die Maustaste los.

Abbildung 46 zeigt das unterschiedliche Ergebnis anhand der beiden Zeichnungsobjekte aus
Abbildung 41. Links das Verschieben eines Punktes eines Polygons, was einfach eine GréRRen-
und Lageveranderung der beiden Verbindungslinien zwischen dem Punkt und seinen Nachbar-
punkten bewirkt, Rechts das Ergebnis einer Verschiebung eines Punkts einer Bézierkurve. Die
verfugbaren Punkte sind in diesem Fall weiter gestreut, daher ist die Basis der Anderung schon
groRer. Dartiber hinaus sind die Kurven aber hier gebogen und nicht linear.

. X 4

Abbildung 46: Punktverschiebung bei Polygon und Bézierkurve

Ohne Maus kénnen Sie wie Ublich einen Punkt durch wiederholtes Strg+Tab ansteuern und ihn
dann mit den Pfeiltasten verschieben; mit Esc schliel3en Sie die Aktion ab.

Punkte einfligen

Abbildung 47: Punkt einfligen
Aktivieren Sie das Symbol Punkte einfligen.
Der Mauszeiger wandelt sich in ein Fadenkreuz.

3. Klicken Sie auf eine Stelle am Rand oder innerhalb des Objekts und lassen Sie die
Maustaste los. Der neue Punkt wird eingeftigt und die Kontur des Objekts entsprechend
verandert (zumindest, wenn Sie nicht exakt die Umrandung getroffen haben). Der Punkt
wird dabei in die Kante eingefligt, die seiner Position am nachsten liegt.

Ohne Maus ist das Verfahren etwas komplizierter:
1. Aktivieren Sie das Symbol Punkte einfiigen.
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Der Mauszeiger wandelt sich in ein Fadenkreuz.

Wahlen Sie Umschalt+irgendeine Pfeiltaste: der Mauszeiger wird im Inneren des Zeich-
nungsobjekts positioniert.

Verschieben Sie das Fadenkreuz dann mit Umschalt+Pfeiltaste

5. Betatigen Sie Umschalt+Enter: der neue Punkt und die neuen Kanten werden als Phantom-
bild angezeigt.

Betatigen Sie ein weiteres Mal Umschalt+Enter: die Anderung wird wirksam.
Schlie3en sie die Aktion mit Esc ab.

Punkte I6schen
Wabhlen Sie einen Punkt des Polygons oder Kurve aus und betétigen Sie dann das Symbol Punkte
I6schen oder die Entf-Taste: der Punkt wird geldscht, die Kontur entsprechend angepasst.

Bézier schlieBen

Dieses Symbol gilt — oberflachlich entgegen seinem Namen, aber Polygone bestehen aus Bézier-
kurven des Grades 1 — auch fur Polygone. Ist es aktiviert, dann ist das Objekt geflllt, andernfalls
hat es keine Fullung.

Umwandeln in ein dreidimensionales Objekt

Mit der Wahl des Menupunktes in 3D konnen Sie aus einem flachen Objekt ein dreidimensionales
erzeugen (Abbildung 48).

Abbildung 48: Umwandeln in ein dreidimensionales Objekt

Dieses Objekt kdnnen Sie nun im dreidimensionalen Raum drehen und kippen. Das Objekt muss
dazu in den Drehmodus versetzt werden, der an den runden Punktmarkierungen wie in Abbildung
49 rechts erkennbar ist. Sie erreichen das durch einfachen weiteren Klick, wenn das Objekt
markiert ist, oder durch Doppelklick auf das Objekt.
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Abbildung 49: Drehen und Kippen

* Den Mittelpunkt, hervorgehoben durch das zusétzliche Fadenkreuz, kbnnen Sie
verschieben, um die Dreh- oder Kippachse zu verandern.

« Durch Verschieben eines Eckpunkts drehen Sie das Objekt ohne Anderung seiner
Geometrie, allerdings andert sich die Farbgebung aufgrund der Anderung im Raum und der
darauf ful3enden Belichtung.

* Durch Bewegen der Seitenmittelpunkte kdnnen Sie das Objekt in waagrechter oder
senkrechter Richtung kippen.

Weitergehende Aktionen mit 3D-Objekten werden in Kapitel 7 — Dreidimensionale Objekte dieses
Handbuchs beschrieben.

Umwandeln in 3D-Rotationskdrper

Das wurde bereits in ,In einen 3D-Rotationskdrper umwandeln® auf Seite 36 behandelt.

In Bitmap

Der derzeitige Zustand des Objekts wird als Rastergrafik ,eingefroren”, das Objekt wird also als
zweidimensionales Konstrukt behandelt, Verschiebungen der Eckpunkte andern die Grole, Ver-
schiebungen der Seitenmittelpunkte verschieben das umrahmende Rechteck zum Parallelogramm,
mit entsprechender Anderung des Objekts. Das Objekt kann iiber Kontextmenii » Speichern...
als Rastergrafik gespeichert werden.

In Metafile

Der Sinn dieser Umwandlung erschlief3t sich noch nicht. Sie entspricht grundsatzlich dem vorigen
Punkt, allerdings lasst sich das Objekt nicht speichern.
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